HIKVISION

Video Access Control Terminal

Quick Start Guide

UD06874B-C

©2018 Hangzhou Hikvision Digital Technology Co., Ltd.

It includes instructions on how to use the Product. The software
embodied in the Product is governed by the user license agreement
covering that Product.

About this Manual

This Manual is subject to domestic and international copyright
protection. Hangzhou Hikvision Digital Technology Co., Ltd.
(“Hikvision”) reserves all rights to this manual. This manual cannot be
reproduced, changed, translated, or distributed, partially or wholly, by
any means, without the prior written permission of Hikvision.
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and are registered trademarks or the subject of applications for the
same by Hikvision and/or its affiliates. Other trademarks mentioned in
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Legal Disclaimer

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE
PRODUCT DESCRIBED, WITH ITS HARDWARE, SOFTWARE AND
FIRMWARE, IS PROVIDED “AS IS”, WITH ALL FAULTS AND ERRORS, AND
HIKVISION MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING
WITHOUT LIMITATION, MERCHANTABILITY, SATISFACTORY QUALITY,
FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF
THIRD PARTY. IN NO EVENT WILL HIKVISION, ITS DIRECTORS, OFFICERS,
EMPLOYEES, OR AGENTS BE LIABLE TO YOU FOR ANY SPECIAL,
CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES, INCLUDING,
AMONG OTHERS, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, OR LOSS OF DATA OR DOCUMENTATION, IN
CONNECTION WITH THE USE OF THIS PRODUCT, EVEN IF HIKVISION
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
REGARDING TO THE PRODUCT WITH INTERNET ACCESS, THE USE OF
PRODUCT SHALL BE WHOLLY AT YOUR OWN RISKS. HIKVISION SHALL
NOT TAKE ANY RESPONSIBILITIES FOR ABNORMAL OPERATION,
PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM CYBER
ATTACK, HACKER ATTACK, VIRUS INSPECTION, OR OTHER INTERNET
SECURITY RISKS; HOWEVER, HIKVISION WILL PROVIDE TIMELY
TECHNICAL SUPPORT IF REQUIRED.

SURVEILLANCE LAWS VARY BY JURISDICTION. PLEASE CHECK ALL
RELEVANT LAWS IN YOUR JURISDICTION BEFORE USING THIS PRODUCT
IN ORDER TO ENSURE THAT YOUR USE CONFORMS THE APPLICABLE
LAW. HIKVISION SHALL NOT BE LIABLE IN THE EVENT THAT THIS
PRODUCT IS USED WITH ILLEGITIMATE PURPOSES.

IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE
APPLICABLE LAW, THE LATER PREVAILS.
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means 0.
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Installation

Before You Start:

® Make sure that the device in the package is in good condition and all the assembly parts are included.
@ Make sure that the wall is strong enough to withstand three times the weight of the terminal.

@ Set the DIP address before installation.
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1. Connect the cables with the connector on the rear
panel of the device.

2. Route the cables through the cable hole of the
mounting plate. The cable holes are on the right
side, left side and lower side of the rear cover.

If the right/left side cable hole is selected, remove
the plastic sheet of the cable hole.
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3.Secure the mounting plate on
the wall with 4 supplied screws.
4.Connect the corresponding
cables.

5.Push the terminal in the
mounting plate from bottom up.

Screws on
the Buttom

6.Tighten the screws on the
bottom of the terminal to fix the
terminal on the mounting plate
and complete the installation.
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Wiring

Under the terminal mode, you can connect the RS-485 cables with RS-485 card reader or secure door control unit.
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Activation

Activating via the Web Client, the SADP tool, and the client software are supported.

@ Activating Device via Client Software

1. Click Device Management icon to enter the Device Management interface.
2. Select an inactive device from the device list. Click Activate to pop up the Activation interface.
3. Create a password and confirm the new password. Click OK to start activate.

4. Click “Edit Network” to configure the device IP address, mask address, gateway address, port No.

A Refresh Every 60s

Add to Client #Add All % Modify Netinfo ) Reset Password Filter

P | Device Type | Firmware Version | security | Server Port | Device Serial No.
XUHKICKX XX0O0000000K XX0O0000000K Inactivate 8000 XX-XXXXXX
XXX X0 XXX Activate 8000 XXXOOHKNX

~

. Activating Device via SADP Tool

1. Download SADP Software: Get the SADP software from the supplied
disk or the official website. Install and run the software.

2. Activate Device: Check the inactive device from the device list. Create a
password in the right side of the interface and confirm the password.

3. Edit Device IP Address: Check the device and manually edit the device
IP address, Port No., Subnet Mask, Gateway, etc.

FCC Information

Please take attention that changes or modification not expressly approved by the party responsible for

' Regulatory Information

compliance could void the user’s authority to operate the equipment.

FCC compliance: This equipment has been tested and found to comply with the limits for a Class B

digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that interference will
not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

—Reorient or relocate the receiving antenna.

—Increase the separation between the equipment and receiver.
—Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
—Consult the dealer or an experienced radio/TV technician for help.
This equipment should be installed and operated with a minimum distance 20cm between the radiator

FCC Conditions

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference.

EU Conformity Statement

Ce

This product and - if applicable - the supplied accessories too
are marked with "CE" and comply therefore with the
applicable harmonized European standards listed under the RE
Directive 2014/53/EU, the EMC Directive 2014/30/EU, the
RoHS Directive 2011/65/EU.

2012/19/EU (WEEE directive): Products marked with this
symbol cannot be disposed of as unsorted municipal waste in
the European Union. For proper recycling, return this product
to your local supplier upon the purchase of equivalent new
equipment, or dispose of it at designated collection points. For
more information see: www.recyclethis.info

2. This device must accept any interference received, including interference that may cause undesired operation.

www.recyclethis.info

2006/66/EC (battery directive): This product
contains a battery that cannot be disposed of
as unsorted municipal waste in the European
Union. See the product documentation for
specific battery information. The battery is
marked with this symbol, which may include
lettering to indicate cadmium (Cd), lead (Pb), or
mercury (Hg). For proper recycling, return the
battery to your supplier or to a designated
collection point. For more information see:

Industry Canada ICES-003 Compliance

* This device meets the CAN ICES-3 (B)/NMB-3(B) standards requirements.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is
subject to the following two conditions:

(1) this device may not cause interference, and

(2) this device must accept any interference, including interference that may cause
undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils
radioexempts de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) I'appareil ne doit pas produire de brouillage, et

(2) I'utilisateur de I'appareil doit accepter tout brouillage radioélectrique subi, méme si le
brouillage est susceptible d'en compromettre le fonctionnement.

Under Industry Canada regulations, this radio transmitter may only operate using an
antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry

* Canada. To reduce potential radio interference to other users, the antenna type and its gain

should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more
than that necessary for successful communication.

Conformément a la réglementation d'Industrie Canada, le présent émetteur radio peut
fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour
|'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique a l'intention des autres utilisateurs, il faut choisir le type d'antenne et son
gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas
I'intensité nécessaire a |'établissement d'une communication satisfaisante.

This equipment should be installed and operated with a minimum distance 20cm between
the radiator and your body.

Cet équipement doit étre installé et utili
radiateur et votre corps.

a une distance minimale de 20 cm entre le

Use only power del § dard
supplies listed in Model Manufacturer Standar
the user DSA-12PFT-12FUK 120100 | Dee Van Enterprise Co., Ltd. | BS
instructions:
DSA-12PFT-12FAU 120100 | Dee Van Enterprise Co., Ltd. AS
DSA-12PFT-12FIN 120100 Dee Van Enterprise Co., Ltd. IS
DSA-12PFT-12FUS 120100 | Dee Van Enterprise Co., Ltd. IEC
DSA-12PFT-12 FBZ 120100 | Dee Van Enterprise Co., Ltd. NBR




Y / +ukvisiov

Video Access Control Terminal

User Manual



Video Access Control Terminal-User Manual

User Manual

©2019 Hangzhou Hikvision Digital Technology Co., Ltd.
This manual is applied for video access control terminal.
Series Model

Video Access Control Terminal DS-K1T501SF

It includes instructions on how to use the Product. The software embodied in the Product is
governed by the user license agreement covering that Product.

About this Manual

This Manual is subject to domestic and international copyright protection. Hangzhou Hikvision
Digital Technology Co., Ltd. (“Hikvision”) reserves all rights to this manual. This manual cannot be
reproduced, changed, translated, or distributed, partially or wholly, by any means, without the
prior written permission of Hikvision.

Trademarks

HIKVISION and other Hikvision marks are the property of Hikvision and are registered
trademarks or the subject of applications for the same by Hikvision and/or its affiliates. Other
trademarks mentioned in this manual are the properties of their respective owners. No right of
license is given to use such trademarks without express permission.

Disclaimer

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, HIKVISION MAKES NO WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THIS MANUAL.
HIKVISION DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE
USE OF THE MANUAL, OR THE CORRECTNESS, ACCURACY, OR RELIABILITY OF INFORMATION
CONTAINED HEREIN. YOUR USE OF THIS MANUAL AND ANY RELIANCE ON THIS MANUAL SHALL BE
WHOLLY AT YOUR OWN RISK AND RESPONSIBILITY.

REGARDING TO THE PRODUCT WITH INTERNET ACCESS, THE USE OF PRODUCT SHALL BE WHOLLY
AT YOUR OWN RISKS. OUR COMPANY SHALL NOT TAKE ANY RESPONSIBILITIES FOR ABNORMAL
OPERATION, PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM CYBER ATTACK, HACKER
ATTACK, VIRUS INSPECTION, OR OTHER INTERNET SECURITY RISKS; HOWEVER, OUR COMPANY
WILL PROVIDE TIMELY TECHNICAL SUPPORT IF REQUIRED.

SURVEILLANCE LAWS VARY BY JURISDICTION. PLEASE CHECK ALL RELEVANT LAWS IN YOUR
JURISDICTION BEFORE USING THIS PRODUCT IN ORDER TO ENSURE THAT YOUR USE CONFORMS
THE APPLICABLE LAW. OUR COMPANY SHALL NOT BE LIABLE IN THE EVENT THAT THIS PRODUCT IS
USED WITH ILLEGITIMATE PURPOSES.

IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW, THE LATER
PREVAILS.

Support

Should you have any questions, please do not hesitate to contact your local dealer.

Data Protection

During the use of device, personal data will be collected, stored and processed. To protect data,
the development of Hikvision devices incorporates privacy by design principles. For example, for
device with facial recognition features, biometrics data is stored in your device with encryption
method; for fingerprint device, only fingerprint template will be saved, which is impossible to
reconstruct a fingerprint image.

As data controller, you are advised to collect, store, process and transfer data in accordance with
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the applicable data protection laws and regulations, including without limitation, conducting
security controls to safeguard personal data, such as, implementing reasonable administrative and

physical security controls, conduct periodic reviews and assessments of the effectiveness of your
security controls.
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Regulatory Information

FCC Information

Please take attention that changes or modification not expressly approved by the party responsible
for compliance could void the user’s authority to operate the equipment.

FCC compliance: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

—Reorient or relocate the receiving antenna.

—Increase the separation between the equipment and receiver.

—Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

—Consult the dealer or an experienced radio/TV technician for help.

This equipment should be installed and operated with a minimum distance 20cm between the
radiator and your body.

FCC Conditions

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause
undesired operation.

EU Conformity Statement

and comply therefore with the applicable harmonized European standards listed
under the RE Directive 2014/53/EU, the EMC Directive 2014/30/EU, the RoHS

Directive 2011/65/EU.
2012/19/EU (WEEE directive): Products marked with this symbol cannot be disposed

of as unsorted municipal waste in the European Union. For proper recycling, return

c E This product and - if applicable - the supplied accessories too are marked with "CE"

this product to your local supplier upon the purchase of equivalent new equipment,

or dispose of it at designated collection points. For more information see:

www.recyclethis.info
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2006/66/EC (battery directive): This product contains a battery that cannot be

disposed of as unsorted municipal waste in the European Union. See the product

documentation for specific battery information. The battery is marked with this

symbol, which may include lettering to indicate cadmium (Cd), lead (Pb), or

mercury (Hg). For proper recycling, return the battery to your supplier or to a
designated collection point. For more information see: www.recyclethis.info

Industry Canada ICES-003 Compliance
This device meets the CAN ICES-3 (B)/NMB-3(B) standards requirements.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to
the following two conditions:

(1) this device may not cause interference, and

(2) this device must accept any interference, including interference that may cause undesired
operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils
radioexempts de licence. L'exploitation est autorisée aux deux conditions suivantes :

(1) I'appareil ne doit pas produire de brouillage, et

(2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, méme si le
brouillage est susceptible d'en compromettre le fonctionnement.

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a
type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce
potential radio interference to other users, the antenna type and its gain should be so chosen that
the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful
communication.

Conformément a la réglementation d'Industrie Canada, le présent émetteur radio peut

fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour
I'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique a
l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la
puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire a
I'établissement d'une communication satisfaisante.

This equipment should be installed and operated with a minimum distance 20cm between the
radiator and your body.

Cet équipement doit étre installé et utilisé a une distance minimale de 20 cm entre le radiateur et
votre corps.

Use only power supplies listed in the user instructions:

Model Manufacturer Standard
DSA-12PFT-12FUK 120100 | Dee Van Enterprise Co., Ltd. | BS
DSA-12PFT-12FAU 120100 | Dee Van Enterprise Co., Ltd. | AS
DSA-12PFT-12FIN 120100 | Dee Van Enterprise Co., Ltd. | IS
DSA-12PFT-12FUS 120100 | Dee Van Enterprise Co., Ltd. | IEC
DSA-12PFT-12 FBZ 120100 | Dee Van Enterprise Co., Ltd. | NBR
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Safety Instruction

These instructions are intended to ensure that user can use the product correctly to avoid danger
or property loss.

The precaution measure is divided into Warnings and Cautions:

Warnings: Neglecting any of the warnings may cause serious injury or death.

Cautions: Neglecting any of the cautions may cause injury or equipment damage.

Warnings Follow | Cautions Follow these
these safeguards to | precautions to prevent
prevent serious | potential  injury or
injury or death. material damage.

A Warnings

® All the electronic operation should be strictly compliance with the electrical safety regulations,
fire prevention regulations and other related regulations in your local region.

® Please use the power adapter, which is provided by normal company. The power consumption
cannot be less than the required value.

® Do not connect several devices to one power adapter as adapter overload may cause over-heat
or fire hazard.

® Please make sure that the power has been disconnected before you wire, install or dismantle
the device.

® When the product is installed on wall or ceiling, the device shall be firmly fixed.

® |f smoke, odors or noise rise from the device, turn off the power at once and unplug the power
cable, and then please contact the service center.

® |f the product does not work properly, please contact your dealer or the nearest service center.
Never attempt to disassemble the device yourself. (We shall not assume any responsibility for
problems caused by unauthorized repair or maintenance.)

A Cautions

® Do not drop the device or subject it to physical shock, and do not expose it to high
electromagnetism radiation. Avoid the equipment installation on vibrations surface or places
subject to shock (ignorance can cause equipment damage).

® Do not place the device in extremely hot (refer to the specification of the device for the detailed
operating temperature), cold, dusty or damp locations, and do not expose it to high
electromagnetic radiation.

® The device cover for indoor use shall be kept from rain and moisture.

® Exposing the equipment to direct sun light, low ventilation or heat source such as heater or
radiator is forbidden (ignorance can cause fire danger).
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® Do not aim the device at the sun or extra bright places. A blooming or smear may occur
otherwise (which is not a malfunction however), and affecting the endurance of sensor at the
same time.

® Please use the provided glove when open up the device cover, avoid direct contact with the
device cover, because the acidic sweat of the fingers may erode the surface coating of the device
cover.

® Please use a soft and dry cloth when clean inside and outside surfaces of the device cover, do
not use alkaline detergents.

® Please keep all wrappers after unpack them for future use. In case of any failure occurred, you
need to return the device to the factory with the original wrapper. Transportation without the
original wrapper may result in damage on the device and lead to additional costs.

® Improper use or replacement of the battery may result in hazard of explosion. Replace with the
same or equivalent type only. Dispose of used batteries according to the instructions provided by
the battery manufacturer.

® Please take care of your card and report card loss in time when card is lost.
® If you require a higher security level, use multiple authentication modes.

® Multiple card types are supported. Please select an appropriate card type according to the card
performance and the usage scenarios.

Vi
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Chapter 1 Overview

1.1 Introduction

DS-K1T501SF is a series video access control terminal with multiple advanced technologies including
fingerprint recognition, face detection, Wi-Fi, smart card recognition, and HD camera (2 MP
optional). It is equipped with fingerprint recognition module (supporting 1:1 mode and 1:N
mode), and supports offline operation.

1.2 Main Features

e Transmission modes of wired network (TCP/TP), Wi-Fi, RS-485, and Wiegand
e Face detection and picture capturing function implemented by built-in camera (2 MP optional)
e Supports RS-485 communication for connecting external card reader

e Supports working as a card reader, and supports Wiegand interface and RS-485 interface for
accessing the controller

e Supports EHome protocol

e Max. 50,000 cards Max. 200,000 access control events records, and Max.3000 fingerprints
storage

e Adopts fingerprint module, supporting 1:N mode (fingerprint, card + fingerprint) and 1:1 mode
(card + fingerprint)

e Supports multiple authentication modes including card, fingerprint, card + fingerprint, card +
password, fingerprint + password, card + fingerprint + password, and so on.

e Supports Mifare card/ QR Code reading

e Tampering detection, unlocking overtime alarm, invalid card swiping over times alarm, duress
card alarm, and so on

e Supports security door control unit connection
e Protection level: IP65

e Data can be permanently saved after power-off

10
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Chapter 2 Appearance
2.1 Appearance of DS-K1T501SF Model

Please refer to the following content for detailed information of the DS-K1T501SF model.
45.5mm

78mm 32.5mm

S
J

0__

218mm

@ 9
—— 0,0

o Do | | &
\ J (7]
Table 2-1 Description of DS-K1T501SF Series Model
No. Description
Mic
Camera
LED Indicator
Fingerprint Scanner and Card Swiping Area
Doorbell Button
Voice Talk Button
Loud Speaker

N WIN|EF

2.2Video Access Control Terminal Connector

The video access control terminal connector is as follows:
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Chapter 3 Installation

Before You Start:
Make sure that the device in the package is in good condition and all the assembly parts are
included.

Make sure that the wall is strong enough to withstand three times the weight of the terminal.

Set the DIP address before installation.

Steps:

1. Connect the cables with the connecter
on the rear panel of the device. Route
the cables through the cable hole of
the mounting plate. The cable holes
are on the right side, left side and
lower side of the rear cover. If the
right/left side cable hole is selected,
remove the plastic sheet of the cable
hole.

2. Secure the mounting plate on the wall
with 4 supplied screws.

3. Connect the corresponding cables.

4, Push the terminal in the mounting
plate from bottom up.

5. Tighten the screws on the bottom of
the terminal to fix the terminal on the
mounting plate and complete the
installation.

ﬂnﬂnﬂ

9 " 9

Screws on
the Buttom
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Chapter 4 Terminal Connection

Group A

INT__Red A1

IN1T  Black A2 :| Power Input
Group B
—1 IN1 Blue

Bl
IN2 Orange
GND_ Black E% :| Alarm Input

NC Red pg
COM_White gg Alarm Output
NO Purple B6

%

=

roup C

1 GND  Black ¢c1 __

w0 Green

W1 White g%

GND Black

LED-OK Brown c5 Wiegand

L ED-ERR OrangeC6
Gray C7

BEEP  Purple C8 —

Group D

—  NC Purple D1 —
COM _ White p2

NO Red

— SENSOR Green y, Lock

BUTTON Gray D5
GND Black D6

}/

GroupkE
— 485+ Yellow E1
485-  Blue RS-485
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Table 4-1 Terminal Description

Terminal
Group | No. Function Color ermind Description
Name
12V DC Power
Al Red +12V Supply
Group A Power Input
A2 Black GND GND
B1 Yellow IN1 Alarm Input 1
B2 Alarm Input Orange IN2 Alarm Input 2
G B B3 Black GND GND
r
OUPE a4 Red NC Aarm Outout
B5 | Alarm Output | White Com arm. .u Py
Wiring
B6 Purple NO
C1 Black GND GND
C2 Green WO Wiegand Wiring O
c3 White W1 Wiegand Wiring 1
C4 Black GND GND
Wiegand
C5 i Brown LED-OK
Group C Wiegand Authenticated
Wiegand
C6 Orange | LED-ERR Authentication
Failed
T ing Al
c7 Gray TAMPER amper'erg arm
Wiring
Cc7 Purple BEEP Buzzer Wiring
D1 Purple NC
D2 White |  COM Lock Wiring
D3 Red NO
Door Magnetic
GroupD | pg Lock Green | SENSOR Signal Input
D5 Gray BUTTON Exit Door erlng
D6 Black GND GND
E1l Yellow 485 + .
Group E RS-485 RS-485 Wiring
E2 Blue 485 -

15
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Chapter 5 Wiring Description

5.1External Device Wiring Overview

Red  +12Vv Al +12V
Powerlnputl: |_Black GND A GND
Group A

Alarm Input Device

_ Blue IN1 B1 Alarm Input Device
Orange IN2 _l
Alarm Input _B'I'ac%_< GND B2 J

B3

Vl\jﬁ(i Cléi/l B4, (NC) [aarm Ouput Devicel.I
ite c a

Alarm Output BUrDle N0 EF\ [TFower } — :

L Group B ( NO)l arm Ouput DevuceIJ

— ﬁd; ?l(l\‘g) c GND
- c2 -
L_\White W1 __ —_—
) c3 External -
Wiegand |__Black  GND__ —_ o Power  Wiegand
Brown |FD-OK Eg SU;‘)NP& Card Reader
—Orange LED-ERR  ___ (g
L Gray  TAMPER —_C7 +12V
Purple  BEEP C
- Group C
Purple NC D1 (NC)
White COM D2 + Power— Electric Dropbolt
Red NO D3 -
Door Lock Green SENSOR D4
Gray BUTTON e
Black_ GND gg 6 — IﬁIIEIectrrc strike
Group D g [ (NO )
Yellow 485+ -
RS485 E :‘: Blue 485- 212 Exit Button ~ Door Magnetic GND
Group E _I

RS-/185 Card Reader

+12V

Notes:
If set the working mode as the controller mode, the terminal can connect the RS-485 card
reader or security control unit via RS-485 protocol. For details about wiring of RS-485 card
reader, see 5.2 The Wiring of External RS-485 Card Reader.

If set the working mode as the controller mode, the terminal cannot connect the Wiegand card
reader.

The security control unit can also connect the external devices. For details, see the specified
user manual of security control unit.
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5.2The Wiring of External RS-485 Card Reader

If set the working mode as the controller mode, the DIP switch No.6 should be set as OFF.
If set the working mode as card reader mode, the DIP switch No. from 1 to 4 should be set as OFF.
Set the external card reader’s RS-485 DIP switch to 2. For details about DIP switch configuration,

see Appendix B DIP Switch Introduction.

External Power Supply Group C (RS485)

Yellow Blue
+12V GND
485+ 485—
~ ™

5.3 Card Reader Connection

The access control terminal can be switched into the card reader mode. It can access to the access
control as a card reader, and supports Wiegand communication port and RS-485 communication

port.

I:Iﬂ NOTE

When the access control terminal works as a card reader, it only supports being connected to the
controller, but does not support alarm input or output, or the connection of external devices.

17
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5. 3. 1 The Wiring of Wiegand

Group C (Wiegand)

External Power Supply

Green White Brown Orange Gray Purple
wo W1 OK ERROR | TAMPER | BUZZER
wo Wi OKLED | FErrorLED Tamper Buzzer

I:Iﬂ NOTE

+12V GND

N

When the access control terminal works as a card reader, you must the WG_ERR, BUZZER and
WG_OK interfaces if you want to control the LED and buzzer of the Wiegand card reader.

Set the working mode of the terminal as card reader, if the terminal is required to work as a
card reader. The card reader mode support to communicate by Wiegand or RS-485.

The distance of Wiegand communication should be no longer than 80 m.
The external power supply and the access control terminal should use the same GND cable.

18
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5. 3. 2The Wiring of RS-485 Output

External Power Supply Group € (R5485)

Yellow Blue
+12V GND
485+ 485—
s ™~

I:Iﬂ NOTE

Set the working mode of the terminal as card reader, if the terminal requires working as a card

reader.
When the access control terminal works as a RS-485 card reader, you can set the RS-485

address via the DIP switch.
The external power supply and the access control terminal should use the same GND cable.

19



Video Access Control Terminal-User Manual

Chapter 6 Activating the Access Control
Terminal

Purpose:
You are required to activate the terminal first before using it.
Activation via SADP, and Activation via client software are supported.
The default values of the control terminal are as follows.

The default IP address: 192.0.0.64.

The default port No.: 8000.

The default user name: admin.

6.1 Activating via SADP Software

SADP software is used for detecting the online device, activating the device, and resetting the
password.

Get the SADP software from the supplied disk or the official website, and install the SADP
according to the prompts. Follow the steps to activate the control panel.

Steps:

1. Runthe SADP software to search the online devices.

2. Check the device status from the device list, and select an inactive device.

@ sabr (0] [m

f I Activate the Device
Total number of online devices: 6 m Refresh

| IPva Address | Port | Software Version | [Pv4 Gateway | HTTP Port | Device Serial No.

Active 8000 V1.4.0build 1609... 80 201
002 Active 8000 V14.2build 1608... 20 16¢ ﬁ
003 Active 8000 V1.4.0build 1609... 80 2
Active 8000 V5.4.0build 1602.. 80 %
The device is not activated
pct 8000 V2.0.1build 1605... 30 4pk

~ 006 DS-K: Inactive 192.0.0.64 8000 V1.0.0build 1608... 0.0.0.0 20 160

You can modify the network parameters after

the device activation.

4 »

3. Create a password in the password field, and confirm the password.

STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong

A password of your own choosing (using a minimum of 8 characters, including upper
case letters, lower case letters, numbers, and special characters) in order to increase
the security of your product. And we recommend you reset your password regularly,
especially in the high security system, resetting the password monthly or weekly can
better protect your product.

4. Click Activate to activate the device.
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5. Check the activated device, you can change the device IP address to the same network
segment with your computer by either modifying the IP address manually or checking the
checkbox of Enable DHCP.

I Modify Network Parameters

Enable DHCP

Device Serial No.:

IP Address

Port: 2000

Subnet Mask:

IPv6 Address: |,
IPv6 Gateway: |,
1Pv6 Prefix Length: |

HTTP Port: |gg

Admin Password:

Modify

Forgot Password

6. Input the password and click the Modify button to activate your IP address modification.

6.2 Activating via Client Software

The client software is versatile video management software for multiple kinds of devices.

Get the client software from the supplied disk or the official website, and install the software
according to the prompts. Follow the steps to activate the control panel.

Steps:

1. Run the client software and the control panel of the software pops up, as shown in the figure
below.
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n

RAI

File System View Tool Help - iVMS-4200 admin @@m 18:40:21 & - a x

-
== Control Panel

Operation and Control

Maintenance and Management

k L schedule and
System Configu
L. Configuring g
=

eting the

nd assigning parameters

@ 5 B} = wotion Detection Alarm

2. Click Device Management to enter the Device Management interface.
3. Check the device status from the device list, and select an inactive device.

Online Device (19) Refresh Every 60s

Add to Client Add All Modify Metinfo Reset Password Activate Filter
1P Device Type Firmware Version Security Server Port | Device Serial Mo. | Start Tir ~
192.0.0.64 Active 8000 . 2017-01
192.168.1.64 8000 201?-01|. 'I

4. Check the device status from the device list, and select an inactive device.
5. Click the Activate button to pop up the Activation interface
6. Inthe pop-up window, create a password in the password field, and confirm the password.

A STRONG PASSWORD RECOMMENDED—- We highly recommend you create a strong

password of your own choosing (using a minimum of 8 characters, including upper
case letters, lower case letters, numbers, and special characters) in order to increase
the security of your product. And we recommend you reset your password regularly,
especially in the high security system, resetting the password monthly or weekly can
better protect your product.
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0o

10.

Activate Device x

Password:

ConfirmPas...

OK Cancel

Click OK button to start activation.

Click the Modify Netinfor button to pop up the Network Parameter Modification interface.
Change the device IP address to the same network segment with your computer by either
modifying the IP address manually.

Input the password and click the OK button to save the settings.

23
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You can set and operate the access control devices via the client software. This chapter will
introduce the access control device related operations in the client software. For integrated

Chapter 7 Client Operation

operations, refer to User Manual of iVMS-4200 Client Software.

7.1 Function Module

Control Panel of iVMS-4200:

File System View Tool Help

A ivms-4200 admin @ &8 B 1e4021 @ - = x

== Control Panel

Operation and Control

Maintenance and Management

@ = E !q Motion Detection Alarm

Menu Bar:
. Search and view the captured pictures stored on local
Open Image File PC.
File Open Video File Search and view the video files recorded on local PC.
Open Log File View the backup log files.
Exit Exit the iVMS-4200 client software.
Lock screen operations. Log in the client again to
Lock
unlock.
Switch User Switch the login user.
Import System Config Import client configuration file from your computer.
System File
Export System Config File | Export client configuration file to your computer.
Set the schedule for backing up the database
Auto Backup including person, attendance data, and permission
data automatically.
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1024*768 Display the window at size of 1024*768 pixels.
1280*%1024 Display the window at size of 1280*1024 pixels.
1440*900 Display the window at size of 1440*900 pixels.
1680*1050 Display the window at size of 1680*1050 pixels.
Maximize Display the window in maximum mode.
Control Panel Enter Control Panel interface.
Main View Open Main View page.
View Remote Playback Open Remote Playback page.
Access Control Enter the Access Control Module.
Status Monitor Enter the Status Monitor Module.
Time and Attendance Enter the Time and Attendance Module.
Security Control Panel Enter the Security Control Panel Module.
Real-time Alarm Enter the Real-time Alarm Module.
Video Wall Open Video Wall page.
E-map Open E-map page.
Auxiliary Screen Preview | Open Auxiliary Screen Preview window.
Device Management Open the Device Management page.
Event Management Open the Event Management page.
Storage Schedule Open the Storage Schedule page.
Account Management Open the Account Management page.
Log Search Open the Log Search page.
System Configuration Open the System Configuration page.
Tool Broadcast Select camera to start broadcasting.
Device Arming Control | Set the arming status of devices.
Alarm Output Control Turn on/off the alarm output.
Batch Wiper Control Batch starting or stopping the wipers of the devices.
Batch Time Sync Batch time synchronization of the devices.
Player Open the player to play the video files.
Message Queue Display the information of Email message to be sent.
Open Video Wizard Opeh the. video guide for the video security
configuration.
Open Video Wall Wizard | Open the guide for the video wall configuration.
Open Security Control Open the guide for the security control panel
Panel Wizard configuration.
Open Access Control and | Open the guide for the access control and video
Help Video Intercom Wizard | intercom configuration.

Open Attendance
Wizard

Open the guide for the time and attendance
configuration.

User Manual (F1)

Click to open the User Manual; you can also open the
User Manual by pressing F1 on your keyboard.

About

View the basic information of the client software.

Language

Select the language for the client software and
reboot the software to activate the settings.
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Selecting Modules
d & Showing/Hiding modules.
For the first time running the software, you can click === on the control
panel to select the modules to display on the Operation and Control area of the control pane.

Steps:

d 1Lk
1. Click B8 to pop up the following dialog.

Selecting Modules »

Video Surveillance

L Main View Remote Playback

Access Control, Security Control, Video Intercom
'1 Access Control “ Status Monitor Time and Attendance
‘ Security Control Panel ? Real-time Alarm

Extended Module

. Alarm Event Video Wall ﬁ E-map
Statistics
@& Heat Map ' People Counting m Counting
i RoadTrafiic Face Retrieval EJ License Plate Retrieval
@ Behavior Analysis g Face Capture
oK Cancel

2. Check the module checkboxes to display them on the control panel according to the actual

needs.
3. Click OK to save the settings.
Notes:

After adding the access control device in Device Management module, the Access Control,
Status, and Time and Attendance module will be displayed on the control panel automatically.
After adding the security control panel in Device Management module, the Security Control
Panel and Real-time Alarm modules will be displayed on the control panel automatically.
The iVMS-4200 client software is composed of the following function modules:
The Main View module provides live view of network cameras and video
encoders, and supports some basic operations, such as picture capturing,
recording, PTZ control, etc.
2% | The Remote Playback module provides the search, playback, export of video
files.
The Access Control module provides managing the organizations, persons,
permissions, and advanced access control functions.
Provides video intercom function.
The Status Monitor module provides monitoring and controlling the door
status, viewing the real-time card swiping records and access control events.

g ¢

]

&Y
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The Time and Attendance module provides setting the attendance rule for the
employees and generating the reports.

The Security Control Panel module provides operations such as arming,
disarming, bypass, group bypass, and so on for both the partitions and zones.
The Real-time Alarm module provides displaying the real-time alarm of
security control panel, acknowledging alarms, and searching the history
alarms.

The Alarm Event module displays the alarm and event received by the client
software.

e ] P Y

=

I
.

The Video Wall module provides the management of decoding device and
video wall and the function of displaying the decoded video on video wall.

The E-map module provides the displaying and management of E-maps, alarm
inputs, hot regions and hot spots.

The Device Management module provides the adding, modifying and deleting
of different devices and the devices can be imported into groups for
management.

The Event Management module provides the settings of arming schedule,
alarm linkage actions and other parameters for different events.

P | os |fE

The Storage Schedule module provides the schedule settings for recording and
pictures.

The Account Management module provides the adding, modifying and
deleting of user accounts and different permissions can be assigned for
different users.

The Log Search module provides the query of system log files and the log files
can be filtered by different types.

Bl b | N

The System Configuration module provides the configuration of general
= parameters, file saving paths, alarm sounds and other system settings.

The function modules are easily accessed by clicking the navigation buttons on the control panel or
by selecting the function module from the View or Tool menu.

You can check the information, including current user, network usage, CPU usage, memory usage
and time, in the upper-right corner of the main page.

7.2 User Registration and Login

For the first time to use iVMS-4200 client software, you need to register a super user for login.

Steps:

1. Input the super user name and password. The software will judge password strength
automatically, and we highly recommend you to use a strong password to ensure your data
security.

2. Confirm the password.

Optionally, check the checkbox Enable Auto-login to log into the software automatically.

4. Click Register. Then, you can log into the software as the super user.

w
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Register Administator x

Please create a super user before proceeding
Super User:

Password:

Confirm Password:

Enable Auto-login

Register Cancel

A\

A user name cannot contain any of the following characters: /\ : * ? “< > [. And the length
of the password cannot be less than 6 characters.

For your privacy, we strongly recommend changing the password to something of your own
choosing (using a minimum of 8 characters, including upper case letters, lower case letters,
numbers, and special characters) in order to increase the security of your product.

Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end-user.

When opening iVMS-4200 after registration, you can log into the client software with the

registered user name and password.

Steps:

1. Input the user name and password you registered.
Note: If you forget your password, please click Forgot Password and remember the encrypted
string in the pop-up window. Contact your dealer and send the encrypted string to him to reset
your password.

2. Optionally, check the checkbox Enable Auto-login to log into the software automatically.

3. Click Login.

& |admin| v
&

Enable Auto-login

Forgot Password Login Cancel

After running the client software, you can open the wizards (including video wizard, video wall
wizard, security control panel wizard, access control and video intercom wizard, and attendance
wizard), to guide you to add the device and do other settings and operations. For detailed
configuration about the wizards, please refer to the Quick Start Guide of iVMS-4200.

7.3 System Configuration

Purpose:
You can synchronize the missed access control events to the client.
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Steps:

1. Click Tool — System Configuration.

2. Inthe System Configuration window, check the Auto-synchronize Access Control Event
checkbox.

3. Set the synchronization time.
The client will auto-synchronize the missed access control event to the client at the set time.

Configure AccessControl parameters

|_| Auto-synchronize Access Control ... 00:00:00

7.4 Access Control Management

Purpose:

The Access Control module is applicable to access control devices and video intercom. It provides
multiple functionalities, including person and card management, permission configuration, access
control status management, video intercom, and other advanced functions.

You can also set the event configuration for access control and display access control points and
zones on E-map.

Note: For the user with access control module permissions, the user can enter the Access Control
module and configure the access control settings.

d Ik
Click 58 in the control panel, and check Access Control to add the Access Control module to
the control panel.

£
Click D-’ to enter the Access Control module.

Search 9+ Add Modify Delete Change Organization -3 Import Person [ Export Person Get Person Add Person in Batch Issue Card in Batch
Add Modify X Delete Input the name or ca...  Search
CEE --on o PersonName  Organization | Gender Card Quantity | Card No. Fingerprint Qu... Face Quantity | Operation
# sub test 1 Wendy test Female 0 0 0 =
2 Cindy test Female 0 0 0 =
3 John test Male 0 0 0 =B
4 Tom test Male 0 0 0 =
Before you start:

For the first time opening the Access Control module, the following dialog will pop up and you are
required to select the scene according to the actual needs.

Non-residence: You can set the attendance rule when adding person, while set the access control
parameters.

Residence: You cannot set the attendance rule when adding person.
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Select Scene

Non-residence Residence

Note: Once the scene is configured, you cannot change it later.

The Access Control module is composed of the following sub modules.

Person and Card

Managing the organizations, persons, and assigning
cards to persons.

Schedule and
Template

Configuring the week schedule, holiday group, and
setting the template.

Permission

Assigning access control permissions to persons and
applying to the devices.

Advanced Function

Providing advanced functions including access control
parameters settings, card reader authentication,
opening door with first card, anti-passing back,
multi-door  interlocking, and authentication
password.

Video Intercom

Video intercom between client and resident,
searching the dial log, and releasing notice.

Searching history events of access control; Searching

Search . .
call logs, unlocking logs, and released notices.
Device Managing the access control devices and video
Management intercom devices.

Note: In this chapter, we only introduce the operations about access control.

7. 4. 1 Adding Access Control Device

Click in the Access Control module to enter the following interface.
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Device for Management (8) Refresh All
Add Modify 3 Delete Remote C... # QR Code Activate EE Device Stat.. ,& Online User  Filter
DEvlceTypé Nickname Connection .| Network Parameters | Device Serial Mo,
Access Controller Access Centroller TCR/IP 10.18.146.86:8000 Ds- 6
Encoding Device 10333159 TCR/IP 10.33.3.159:8000 DS- 3
Enceding Device 10.16.6.250 TCP/IP 10.16.6.250:8000 201
Encoding Device 10.20.132.215 TCR/IP 10.20132215:8000 DS+ 7
Encoding Device 10.66.76.193 TCP/IP 10.66.76.193:8005 DS~ J
Indoor Station Indoor Station TCR/IP 10.16.6.104:8000 Ds- U
Security Control Panel  Security Control Pa... TCP/IP 10.18.146.51:8000 D5- U
Security Control Panel  10.16.6.92 TCR/IP 10.16.6.92:3000 DS~ 7
Online Device (19) Refresh Every 605
Add to Client Add All Modify Metinfo Reset Password Activate Filter
P i Device Type Firmware Version Security ServerPort | Device Serial No. | Start Tit ~
1016.6.92 D¢ i} W i Active 8000 D . 2017-01
192.0.0.64 Df W il Active 8000 D 2017-01[ |

Note: After adding the device, you should check the device arming status in Tool — Device Arming
Control. If the device is not armed, you should arm it, or you will not receive the real-time events
via the client software. For details about device arming control, refer 7.13 Arming Control.

Creating Password

Purpose:

For some devices, you are required to create the password to activate them before they can be

added to the software and work properly.

Note: This function should be supported by the device.

Steps:

1. Enter the Device Management page.

2. Onthe Device for Management or Online Device area, check the device status (shown on
Security column) and select an inactive device.

Online Device (19}

Refresh Every 60s

Add to Client Add All Modify Netinfo Reset Password Activate Filter
P ’ Device Type Firmware Versicn Security Server Port | Device Serial Mo. | Start Tir ~
1920064 Active 8000 . 2017-01
192168.1.64 8000 201?—01| |

3. Click the Activate button to pop up the Activation interface.
4. Create a password in the password field, and confirm the password.

STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong password
of your own choosing (using a minimum of 8 characters, including upper case letters, lower
case letters, numbers, and special characters) in order to increase the security of your product.
And we recommend you reset your password reqularly, especially in the high security system,
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resetting the password monthly or weekly can better protect your product.

R

User Name: admin

Password:

Confirm Password:

Enable Hik-Connect

0K Cancel

5. (Optional) Enable Hik-Connect service when activating the device if the device supports.
1) Check Enable Hik-Connect checkbox to pop up the Note dialog.

- .

To enable Hik-Connect senice, you need to create a verification code or change the
verification code

Verification Code:

6 to 12 letters or numbers, case sensitive. You are
recommended to use a combination of no less than 8 letters
or numbers.

Confirm Verification Code:

The Hik-Connect service will require internet access. Please read the “Terms of Service”
and "Privacy Policy” before enabling the semvice.

OK Cancel

2) Create a verification code.
3) Confirm the verification code.
4) Click Terms of Service and Privacy Policy to read the requirements.
5) Click OK to enable the Hik-Connect service.
6. Click OK to activate the device.
A “The device is activated.” window pops up when the password is set successfully.
7. Click Modify Netinfo to pop up the Modify Network Parameter interface.
Note: This function is only available on the Online Device area. You can change the device IP
address to the same subnet with your computer if you need to add the device to the software.
8. Change the device IP address to the same subnet with your computer by either modifying the
IP address manually or checking the checkbox of DHCP.
9. Input the password set in step 4 and click OK to complete the network settings.
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Modify Network Parameter x

MAC Address: Copy

Software Version: Copy

Device Serial Mo.: Copy
DHCP

Port: 2000

~ IPvd{Dont Save)

IP Address: 10.16.1.233

Subnet Mask: 255.255.255.0

Gateway: 10.16.1.254
IPvG(Don't Save)

Password: sssssssse

OK Cancel

Adding Online Device

Purpose:

The active online devices in the same local subnet with the client software will be displayed on the
Online Device area. You can click the Refresh Every 60s button to refresh the information of the
online devices.

Note: You can click to hide the Online Device area.

Online Device (19) Refresh Every 605

Add to Client Add Al Maodify Metinfo Reset Password Activate Filter
P ’ Device Type Firmware Versicn Security Server Port | Device Serial Mo. | Start Tir ~
10.16.6.236 D 4 Active 8000 [ . 2017-01

10.16.6.92 D 3 Active 8000 0 . 2007-01(

192.0.0.64 D 1 Active &000 1 . 2007-01 -

Steps:

1. Select the devices to be added from the list.
Note: For the inactive device, you need to create the password for it before you can add the
device properly. For detailed steps, please refer to Chapter 6 Activating the Access Control
Terminal.

2. Click Add to Client to open the device adding dialog box.

3. Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address. The IP address of the device is obtained automatically in
this adding mode.
Port: Input the device port No. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password.

JAN

STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong password
of your own choosing (using a minimum of 8 characters, including upper case letters, lower
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case letters, numbers, and special characters) in order to increase the security of your product.
And we recommend you reset your password regularly, especially in the high security system,
resetting the password monthly or weekly can better protect your product.
4. Optionally, check the Export to Group checkbox to create a group by the device name.
You can import all the channels of the device to the corresponding group by default.
Note: iVMS-4200 also provides a method to add the offline devices.
1) Check the Add Offline Device checkbox.
2) Input the required information, including the device channel number and alarm input
number.
3) Click Add.
When the offline device comes online, the software will connect it automatically.
5. Click Add to add the device.

Add »

Adding Mode:

@ IP/Domain IP Segment Hik-ConnectD... EHome Serial Port
IP Server HIDDNS Batch Import

Add Offline Device

Nickname: [l
Address: 192.0.0.64
Port: 8000

User Name:

Password:

~/ Exportio Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Add Cancel

Adding Multiple Online Device

If you want to add multiple online devices to the client software, click and hold Ctr/ key to
select multiple devices, and click Add to Client to open the device adding dialog box. In the
pop-up message box, enter the user name and password for the devices to be added.

Adding All Online Devices

If you want to add all the online devices to the client software, click Add All and click OK in the
pop-up message box. Then enter the[ user name and password for the devices to be added.
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Adding Mode:

@ IP/Domain IP Segment Hik-ConnectD... EHome Serial Port

IP Server HIDDNS Batch Import

User Name: [l

Password:

+/ Exportto Group

Create group with device IP.

Add Cancel

Adding Devices by IP or Domain Name

Steps:

1.
2.
3.

Click Add to open the device adding dialog box.

Select IP/Domain as the adding mode.

Input the required information.

Nickname: Edit a name for the device as you want.

Address: Input the device’s IP address or domain name.

Port: Input the device port No. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password.

JAN

STRONG PASSWORD RECOMMENDED—- We highly recommend you create a strong password

of your own choosing (using a minimum of 8 characters, including upper case letters, lower

case letters, numbers, and special characters) in order to increase the security of your product.

And we recommend you reset your password regularly, especially in the high security system,

resetting the password monthly or weekly can better protect your product.

Optionally, check the Export to Group checkbox to create a group by the device name.

You can import all the channels of the device to the corresponding group by default.

Note: iVMS-4200 also provides a method to add the offline devices.

1) Check the Add Offline Device checkbox.

2) Input the required information, including the device channel number and alarm input
number.

3) Click Add.

When the offline device comes online, the software will connect it automatically.

5. Click Add to add the device.
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Add »

Adding Mode:

@ IP/Domain IP Segment Hik-ConnectD... EHome Serial Port
IP Server HIDDNS Batch Import

Add Offline Device

Nickname: [l
Address:

Port: 8000
User Name:

Password:

~/ Exportio Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Add Cancel

Adding Devices by IP Segment

Steps:

1. Click Add to open the device adding dialog box.
2. Select IP Segment as the adding mode.

3. Input the required information.

Start IP: Input a start IP address.

End IP: Input an end IP address in the same network segment with the start IP.
Port: Input the device port No.. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password.

JAN

STRONG PASSWORD RECOMMENDED—- We highly recommend you create a strong password

of your own choosing (using a minimum of 8 characters, including upper case letters, lower

case letters, numbers, and special characters) in order to increase the security of your product.

And we recommend you reset your password regularly, especially in the high security system,

resetting the password monthly or weekly can better protect your product.

Optionally, check the Export to Group checkbox to create a group by the device name.

You can import all the channels of the device to the corresponding group by default.

Note: iVMS-4200 also provides a method to add the offline devices.

1) Check the Add Offline Device checkbox.

2) Input the required information, including the device channel number and alarm input
number.

3) Click Add.

When the offline device comes online, the software will connect it automatically.

Click Add.

You can add the device which the IP address is between the start IP and end IP to the device

list.
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Add ®
Adding Mode:
IP/Domain % |P Segment Hik-ConnectD... EHome Serial Port
IP Server HIDDNS Batch Import
Add Offline Device
Start IP: l ]
End IP:
Port: 8000
User Name:
Password:
~/ Exportio Group
Create group with device IP.
Add Cancel
Adding Devices by Hik-Connect Domain
Purpose:
You can add the devices connected via Hik-Connect by inputting the Hik-Connect account and
password.

Before you start: Add the devices to Hik-Connect account via iVMS-4200, iVMS-4500 Mobile Client,
or Hik-Connect first. For details about adding the devices to Hik-Connect account via iVMS-4200,
refer to the User Manual of iVMS-4200 Client Software.

Add Single Device

Steps:

1.

2.
3.
4

Click Add to open the device adding dialog.

Select Hik-Connect Domain as the adding mode.

Select Single Adding.

Input the required information.

Nickname: Edit a name for the device as you want.

Device Serial No.: Input the device serial No.

User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password.

A\

STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong password
of your own choosing (using a minimum of 8 characters, including upper case letters, lower
case letters, numbers, and special characters) in order to increase the security of your product.
And we recommend you reset your password reqularly, especially in the high security system,
resetting the password monthly or weekly can better protect your product.

Hik-Connect Account: Input the Hik-Connect account.

Hik-Connect Password: Input the Hik-Connect password.

Optionally, check the Export to Group checkbox to create a group by the device name.

You can import all the channels of the device to the corresponding group by default.
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6. Click Add to add the device.

Adding Mode:

IP/Domain

IP Server

Nickname: [|

IP Segment O

HIDDNS

Adding Mode:

Hik-ConnectD... EHome Serial Port

Batch Import

Batch Adding @) Single Adding

Device Serial No.:
User Name:
Password:
Hik-Connect Account:

Hik-Connect Password:

~ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Add Cancel
Add Devices in Batch
Steps:
1. Click Add to open the device adding dialog.
Add
Adding Mode:
IP/Domain IP Segment % Hik-ConnectD... EHome Serial Port
IP Server HIDDNS Batch Import
Adding Mode: @ Batch Adding Single Adding
Hik-Connect Account.
Hik-Connect Password:
Get Device List
Add Cancel

2. Select Hik-Connect Domain as the adding mode.

w

Select Batch Adding.

4. Input the required information.
Hik-Connect Account: Input the Hik-Connect account.
Hik-Connect Password: Input the Hik-Connect password.

5. Click Get Device List to show the devices added to Hik-Connect account.
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Add x
Adding Mode:
IP/Domain IP Segment %) Hik-ConnectD... EHome Serial Port
IP Server HIDDNS Batch Import
Current Account:  11guah | ™ Logout |  Search...
Nickname | IP Device Serial No.
M (.. 14 .92 cs 80588
[} 10... 1] 18 DS 46843725
D 8. 1] 18 Ds 1891952
D! .. 1] 18 DS 2418E
M 2. I .92 cs
User Mame: Password:
«/ Exportto Group
Setthe device name as the group name and add all the channels connected to the device to the group.
Add Cancel

6. Check the checkbox(es) to select the device as desired.

Input the user name and password for the devices to be added.

8. Optionally, check the Export to Group checkbox to create a group by the device name.
You can import all the channels of the device to the corresponding group by default.

9. Click Add to add the devices.

.

Adding Devices by EHome Account

Purpose:

You can add access control device connected via EHome protocol by inputting the EHome account.
Before you start: Set the network center parameter first. For details, refer to Chapter 7.4.4
Network Settings.

Steps:

1. Click Add to open the device adding dialog box.

2. Select EHome as the adding mode.

Add x
Adding Mode:
IP/Domain IP Segment Hik-ConnectD... & EHome Serial Port
IP Server HIDDNS Batch Import
Nickname: [l
Account

+/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

This adding mode only suppors to add access control devices.

Add Cancel

3. Input the required information.
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5.

Nickname: Edit a name for the device as you want.

Account: Input the account name registered on EHome protocol.

Optionally, check the Export to Group checkbox to create a group by the device name.

You can import all the channels of the device to the corresponding group by default.

Note: iVMS-4200 also provides a method to add the offline devices.

1) Check the Add Offline Device checkbox.

2) Input the required information, including the device channel number and alarm input
number.

3) Click Add.

When the offline device comes online, the software will connect it automatically.

Click Add to add the device.

Adding Devices by Serial Port

Purpose:
You can add access control device connected via serial port.
Steps:
1. Click Add to open the device adding dialog box.
2. Select Serial Port as the adding mode.
Add ®
Adding Mode:
IP/Domain IP Segment Hik-ConnectD... EHome @ Serial Port
IP Server HIDDNS Batch Import
Nickname: [l
Serial Port No. CONMA -
Baud Rate 19200
DIF: 1
-/ Exportto Group
Setthe device name as the group name and add all the channels
connected to the device to the group.
This adding mode only supports to add access control devices.
Add Cancel
3. Input the required information.
Nickname: Edit a name for the device as you want.
Serial Port No.: Select the device’s connected serial port No.
Baud Rate: Input the baud rate of the access control device.
DIP: Input the DIP address of the device.
4. Optionally, check the Export to Group checkbox to create a group by the device name.

You can import all the channels of the device to the corresponding group by default.

Note: iVMS-4200 also provides a method to add the offline devices.

1) Check the Add Offline Device checkbox.

2) Input the required information, including the device channel number and alarm input
number.

3) Click Add.
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5.

When the offline device comes online, the software will connect it automatically.
Click Add to add the device.

Adding Devices by IP Server

Steps:
1. Click Add to open the device adding dialog box.
2. Select IP Server as the adding mode.
Add ®
Adding Mode:
IP/Domain IP Segment Hik-ConnectD... EHome Serial Port
2 |P Server HIDDNS Batch Import
Add Offline Device
Nickname: l
Server Address:
Device 1D:
User Name:
Password:
+ Exportto Group
ootz to e dovics o the aroun,
Add Cancel
3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: Input the IP address of the PC that installs the IP Server.
Device ID: Input the device ID registered on the IP Server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password.
STRONG PASSWORD RECOMMENDED—- We highly recommend you create a strong password
of your own choosing (using a minimum of 8 characters, including upper case letters, lower
case letters, numbers, and special characters) in order to increase the security of your product.
And we recommend you reset your password regularly, especially in the high security system,
resetting the password monthly or weekly can better protect your product.
4. Optionally, check the Export to Group checkbox to create a group by the device name.

You can import all the channels of the device to the corresponding group by default.

Note: iVMS-4200 also provides a method to add the offline devices.

1) Check the Add Offline Device checkbox.

2) Input the required information, including the device channel number and alarm input
number.

3) Click Add.

When the offline device comes online, the software will connect it automatically.

5. Click Add to add the device.
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Adding Devices by HiDDNS

Steps:
1. Click Add to open the device adding dialog box.
2. Select HIDDNS as the adding mode.
Add ®
Adding Mode:
IP/Domain IP Segment Hik-ConnectD... EHome Serial Port
IP Server 2 HIDDNS Batch Import
Add Offline Device
Nickname: l
Server Address: www.hik-online.com
Device Domain Mame:
User Name:
Password:
+ Exportto Group
ootz to e dovics o the aroun,
Add Cancel
3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: www.hik-online.com.
Device Domain Name: Input the device domain name registered on HiDDNS server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password.
STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong password
of your own choosing (using a minimum of 8 characters, including upper case letters, lower
case letters, numbers, and special characters) in order to increase the security of your product.
And we recommend you reset your password regularly, especially in the high security system,
resetting the password monthly or weekly can better protect your product.
4. Optionally, check the Export to Group checkbox to create a group by the device name.

You can import all the channels of the device to the corresponding group by default.

Note: iVMS-4200 also provides a method to add the offline devices.

1) Check the Add Offline Device checkbox.

2) Input the required information, including the device channel number and alarm input
number.

3) Click Add.

When the offline device comes online, the software will connect it automatically.

5. Click Add to add the device.

Importing Devices in Batch

Purpose:

42


http://www.hik-online.com/

Video Access Control Terminal-User Manual

The devices can be added to the software in batch by inputting the device information in the
pre-defined CSV file.

Steps:

1. Click Add to open the device adding dialog box.

2. Select Batch Import as the adding mode.

Add »

Adding Mode:

IP/Domain IP Segment Hik-ConnectD... EHome Serial Port
IP Server HIDDNS @ Batch Import

File (*.csv): |

Export Template

Add Cancel

3. Click Export Template and save the pre-defined template (CSV file) on your PC.
4. Open the exported template file and input the required information of the devices to be added
on the corresponding column.

Nickname: Edit a name for the device as you want.
Adding Mode: You can input O, 2, 3, 4, 5, or 6 which indicated different adding modes. 0
indicates that the device is added by IP address or domain name; 2 indicates that the
device is added via IP server; 3 indicates that the device is added via HiDDNS; 4 indicates
that the device is added via EHome protocol; 5 indicates that the device is added by serial
port; 6 indicates that the device is added via Hik-Connect Domain.
Address: Edit the address of the device. If you set 0 as the adding mode, you should input
the IP address or domain name of the device; if you set 2 as the adding mode, you should
input the IP address of the PC that installs the IP Server; if you set 3 as the adding mode,
you should input www.hik-online.com.
Port: Input the device port No.. The default value is 8000.
Device Information: If you set 0 as the adding mode, this field is not required; if you set 2
as the adding mode, input the device ID registered on the IP Server; if you set 3 as the
adding mode, input the device domain name registered on HiDDNS server; if you set 4 as
the adding mode, input the EHome account; if you set 6 as the adding mode, input the
device serial No.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password.

A\

STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong password
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of your own choosing (using a minimum of 8 characters, including upper case letters, lower
case letters, numbers, and special characters) in order to increase the security of your product.
And we recommend you reset your password regularly, especially in the high security system,
resetting the password monthly or weekly can better protect your product.

Add Offline Device: You can input 1 to enable adding the offline device, and then the
software will automatically connect it when the offline device comes online. 0 indicates
disabling this function.
Export to Group: You can input 1 to create a group by the device name (nickname). All the
channels of the device will be imported to the corresponding group by default. 0 indicates
disabling this function.
Channel Number: If you set 1 for Add Offline Device, input the channel number of the
device. If you set 0 for Add Offline Device, this field is not required.
Alarm Input Number: If you set 1 for Add Offline Device, input the alarm input number of
the device. If you set O for Add Offline Device, this field is not required.
Serial Port No.: If you set 5 as the adding mode, input the serial port No. for the access
control device.
Baud Rate: If you set 5 as the adding mode, input the baud rate of the access control
device.
DIP: If you set 5 as the adding mode, input the DIP address of the access control device.
Hik-Connect Account: If you set 6 as the adding mode, input the Hik-Connect account.
Hik-Connect Password: If you set 6 as the adding mode, input the Hik-Connect password.
5. Click =/ and select the template file.
6. Click Add to import the devices.
The devices will be displayed on the device list for management after added successfully. You can
check the resource usage, HDD status, recording status, and other information of the added
devices on the list.
Click Refresh All to refresh the information of all added devices. You can also input the device
name in the filter field for search.

7. 4. 2Viewing Device Status

In the device list, you can select the device and then click Device Status button to view its status.

44



Video Access Control Terminal-User Manual

Device Status x

Device: Video Access Control Terminal

_ Door Name Door Lock Status| Door Status Door Magnetic -

Host Status 1 Close Mormal Status Close
Card Reader Status

Alarm Output Status

Event Sensor Status

Secure Door Control Unit Status

Refresh Cancel

Note: The interface may different from the picture displayed above. Refer to the actual interface
when adopting this function.
Door Status: The status of the connected door.
Host Status: The status of the host, including Storage Battery Power Voltage, Device Power
Supply Status, Multi-door Interlocking Status, Anti-passing Back Status, and Host Anti-Tamper
Status.
Card Reader Status: The status of card reader.
Note: If you use the card reader with RS-485 connection, you can view the status of online or
offline. If you use the card reader with Wiegand connection, you can view the status of offline.
Alarm Output Status: The alarm output status of each port.
Event Sensor Status: The event sensor status of each port.
Secure Door Control Unit Status: The online status and tamper status of the Secure Door
Control Unit.

7. 4. 3 Editing Basic Information

Purpose:

After adding the access control device, you can edit the device basic information.
Steps:

1. Select the device in the device list.

2. Click Modify to pop up the modifying device information window.

3. Click Basic Information tab to enter the Basic Information interface.
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Adding Mod
&9 Network Settings St
& Capture Settings & |PDomain IP Segment Hik-ConnectD... EHome Serial Port
[ Rs-485 Settings
IP Server HIiDDMS Batch Import

Nickname: Video Access Control Terminal
Address IXXKXXXXX ]
Port: 8000

User Mame: admin

Password: sessnsee

Modify Cancel

4. Edit the device information, including the adding mode, the device name, the device IP address,
port No., user name, and the password.

7. 4. 4 Network Settings

Purpose:

After adding the access control device, you can set the uploading mode, and set the network
center and wireless communication center.

Select the device in the device list, and click Modify to pop up the modifying device information
window.

Click Network Settings tab to enter the network settings interface.

Uploading Mode Settings

Purpose :

You can set the center group for uploading the log via the EHome protocol.
Steps:
1. Click the Uploading Mode tab.

46



Video Access Control Terminal-User Manual

Modify x

{83 Basic Information Uploading Mode | Network Center Wirelass Communication Center

& Capture Settings
@ R5-485 Settings Center Group: ‘CemerGruum el

~ Enable

Uploading Mode
Main Channel: N1 hd
Backup Channel: Close ~

Save

2. Select the center group in the dropdown list.

Check the Enable checkbox to enable the selected center group.

4. Select the uploading mode in the dropdown list. You can enable N1/G1 for the main channel
and the backup channel, or select Close to disable the main channel or the backup channel.
Note: The main channel and the backup channel cannot enable N1 or G1 at the same time.

5. Click Save button to save parameters.

w

Network Center Settings

You can set the account for EHome protocol in Network Settings page. Then you can add devices
via EHome protocol.

Steps:

1. Click the Network Center tab.

Modify x

£33 Basic Information Uploading Mode Metwork Center Wireless Communication Center

& Capture Settings
[&] Rs-485 Settings Center Group: Center1 w7

Address Type: |P Address o

IP Address: [XXXXXX)(X
Port: 7660
Protocol Type: EHome »
Account zhang

Save

2. Select the center group in the dropdown list.
3. Select the Address Type as IP Address or Domain Name.

47



Video Access Control Terminal-User Manual

Input IP address or domain name according to the address type.

Input the port No. for the protocol. By default, the port No. is 7660.

Select the protocol type as EHome.

Set an account name for the network center.

Note: The account should contain 1 to 32 characters and only letters and numbers are allowed.
8. Click Save button to save parameters.

Notes:

The port No. of the wireless network and wired network should be consistent with the port No.
of EHome.

You can set the domain name in Enable NTP area Editing Time section in Remote Configuration.
For details, refer to Time in 7.4.7 Remote Configuration.

No vk

Wireless Communication Center Settings

Steps:
1. Click the ireless Communication Center tab. _
I

83 Basic Information

ra Uploading Mode Network Center Wireless Communication Center
]
& Capture Settings
[ Rs-485 Settings APN Name: | v

SIM Card Mo.:
Center Group: Centert v
IF Address:
Port:
Protocol Type: v
Account:

Save

Select the APN name as CMINET or UNINET.

Input the SIM Card No.

Select the center group in the dropdown list.

Input the IP address and port No.

Select the protocol type as EHome. By default, the port No. for EHome is 7660.

Set an account name for the network center. A consistent account should be used in one
platform.

8. Click Save button to save parameters.

Note: The port No. of the wireless network and wired network should be consistent with the port
No. of EHome.

NoukwnN
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7. 4. 5 Capture Settings

You can set the parameters of capture linkage and manual capture.
Select the device in the device list, and click Modify to pop up the modifying device information
window.
Click Capture Settings tab to enter the capture settings interface.
Notes:
The Capture Settings should be supported by the device.
Before setting the capture setting, you should configure the storage server for picture storage.

Linked Capture

Steps:
1. Select the Linked Capture tab.

8% Basic Information

Linked Capture | Manual Capture
&9 Network Settings

Picture Size hd
[ RS-485 Settings
Picture Quality High ke
Capture Times: 0 >
Capture Interval 1: ms
Capture Interval 2: ms
Capture Interval 3 ms

Capture Interval 4: ms

Save

Set the picture size and quality.

Set the linked capture times once triggered.

Set the capture interval according to the capture times.
Click Save to save the settings.

vk wnN

Manual Capture

Steps:
1. Select the Manual Capture tab.
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ﬁ% Baszic Information
&Y Network Settings
L

=] RS-485 Settings

Linked Capture Manual Capture

Picture Size:

Picture Quality:

CIF

High

Save

Restore Defa...

2. Select the resolution of the captured pictures from the dropdown list.
Note: The supported resolution types are CIF, QCIF, 4CIF/D1, SVGA, HD720P, VGA, WD1, and

AUTO.

3. Select the picture quality as High, Medium, or Low.

4. Click Save to save the settings.
5. You can click Restore Default Value to restore the parameters to default settings.

7. 4. 6 RS-485 Settings

Purpose:

You can set the RS-485 parameters including the serial port, the baud rate, the data bit, the stop
bit, the parity type, the communication mode, the working mode, and the connection mode.
Note: The RS-485 Settings should be supported by the device.

Steps:

1. Select the device in the device list, and click Modify to pop up the modifying device

information window.

2. Click RS-485 Settings tab to enter the RS-485 settings interface.
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8% Basic Information
& MNetwork Settings
& Capture Settings

Serial Port: |'| "'|

Baud Rate: 600 v

Data Bit  7Bit v

Stop Bit  1Bit @

Parity.:  Mone o

Communication Mode:  Half Duplex ©

Working Mode: Console v

Connection Mode:  Connect Card Reader v

Save

2. Select the serial No. of the port from the dropdown list to set the RS-485 parameters.

3. Set the baud rate, data bit, the stop bit, parity type, communication mode, work mode, and the
connection mode in the dropdown list.

4. Click Save to save the settings and the configured parameters will be applied to the device
automatically.

Note: After changing the working mode, the device will be rebooted. A prompt will be popped up

after changing the working mode.

7. 4. 7TRemote Configuration

Purpose:
In the device list, select the device and click Remote Configuration button to enter the remote
configuration interface. You can set the detailed parameters of the selected device.

Checking Device Information

Steps:
1. Inthe device list, you can click Remote Configuration to enter the remote configuration
interface.

2. Click System -> Device Information to check the device basic information and the device
version information.
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Basic Information

Device Type: Local Trigger Mumber: 1
Electric Lock Number. 1 Local RS-485 Number. 1

Device Serial Mo.:
Version Information

Firmware Version: ¥1.1.0 build

Hardware Version: 010001

Editing Device Name

In the Remote Configuration interface, click System -> General to configure the device name and
overwrite record files parameter. Click Save to save the settings.

Device Information

Device Mame:  Access Controller

Cwverwrite Record Files: Mo ad

Save

Editing Time

Steps:

1. Inthe Remote Configuration interface, click System -> Time to configure the time zone.

2. (Optional) Check Enable NTP and configure the NTP server address, the NTP port, and the
synchronization interval.

3. (Optional) Check Enable DST and configure the DST star time, end time and the bias.

4. Click Save to save the settings.
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Time Zone

Select Time Zone: (GMT+08:00) Beijing, Hong Kong, Perth, Singa... |~

Enable NTP

Server Address:

NTP Port: 123
SyncInterval: 0 Minute(s)
Enable DST
Start Time:  April First Week Sun 2 100
End Time: October Last Week 3un 2 00
DST Bias: |60 min

Save

Setting System Maintenance

Purpose:
You can reboot the device remotely, restore the device to default settings, import configuration file,
upgrade the device, etc.
Steps:
1. Inthe Remote Configuration interface, click System -> System Maintenance.
2. Click Reboot to reboot the device.
Or click Restore Default Settings to restore the device settings to the default ones, excluding
the IP address.
Or click Restore All to restore the device parameters to the default ones. The device should be
activated after restoring.
Note: The configuration file contains the device parameters.
Or click Import Configuration File to import the configuration file from the local PC to the
device.
Or click Export Configuration File to export the configuration file from the device to the local
PC
Note: The configuration file contains the device parameters.
3. You can also remote upgrade the device.
1) Inthe Remote Upgrade part, click |~ to select the upgrade file.
2) Click Upgrade to start upgrading.
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System Management

Reboot
Restore Default Settings
Restore All
Impaort Configuration File
Export Configuration File

Remote Upgrade

Select Type: |Controller Upgrade

Select File: Upgrade

Progress: [

Managing User

Steps:
1. Inthe Remote Configuration interface, click System -> User.

& Add 7 Edit T Delete
User Name Priority IP Address MAC Address Password Security
admin Administrator 0.0.00 00:00:00:00:00:00  Risky

2. Click Add to add the user (Do not support by the elevator controller.).
Or select a user in the user list and click Edit to edit the user. You are able to edit the user
password, the IP address, the MAC address and the user permission. Cilck OK to confirm
editing.
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| User Parameter - . l&,l
User Information

l User Type: Administrator User Name: admin
Password: | Confirm Password:
IP Address: 0.0.0.0 MAC Address: 00:00:00:00:00:00

User Permission

~ Remote Operation: Alarm Disarming
~ Arm

~ Remote Log Search/Status

~ Remote Shutdown / Reboot

~/ Remote Parameter Settings

~/ GetParameters

~ Restore Default Settings

~/ Remote Upgrade

Save Cancel

Setting Security
Steps:
1. Click System -> Security.

Encryption Mode

Level: Compatible Mode v
Software
Enable S5H

~/ Enable lllegal Login Lock
Save

2. Select the encryption mode in the dropdown list.
You can select Compatible Mode or Encryption Mode.
3. Click Save to save the settings.

Configuring Network Parameters

Click Network -> General. You can configure the NIC type, the IPv4 address, the subnet mask (IPv4),
the default gateway (IPv4), MTU address, MTU, and the device port. Click Save to save the settings.

MNIC Type: 10MA00MA000M Self-... |~
IPv4 Address:
Subnet Mask (IPvd):
Default Gateway (IPvd):
MAC Address:
MTU(Byte): 1500

Device Port: 8000

Save
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Configuring Upload Method

Purpose :
You can set the center group for uploading the log via the EHome protocol.

Steps:
1. Click Network -> Report Strategy.

Center Group: Center Group1 v
~ Enable

Uploading Method Configuration

Main Channel: M1 v | Settings
Backup Channel 1: Close g
Backup Channel 2: Close

Backup Channel 3: Close

Save

2. Select a Center Group from the drop-down list.
3. Check the Enable check box.
4. Set the uploading method.
You can set the main channel and the backup channel.
5. Click Settings on the right of the channel field to set the detailed information.
6. Click Save to save the settings.

Configuring Network Center

You can set the notify surveillance center, center’s IP address, the port No., the Protocol (EHome),
and the EHome account user name to transmit data via EHome protocol. For details about EHome
protocol’s transmission, refer to Network Center Settings in Chapter 7.4.4 Network Settings. Click
Save to save the settings or click

Motify Surveillance Center: Metwaork Center w

IP Address: 0.0.0.0

Port: 0
Protocol Type: w

lser Mame:

Save Cancel
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Configuring Advanced Network

Click Network -> Advanced Settings. You can configure the DNS IP address 1, the DNS IP address 2,
the security control platform IP, and the security control platform port. Click Save to save the
settings.

DMNS1 IP Address: 0.0.0.0
DMWS2 IP Address: 0.0.0.0
Security Control Platform... 0.0.0.0

Security Control Platform... 0

Save
Configuring Wi-Fi
Steps:
1. Click Network —> Wi-Fi.
~ Enable
Hot Spot Mame: Select...
Password:
Display Passwaord
Encryption Mode: Mone
Connect Status: Mot Connect Fail Reason: Unknown Error Refresh

MIC Type: Auto Switch v
Enable DHCP:
IP Address: 192.168.0.10
Subnet Mask: 2552552550
Default Gateway: 0.0.0.0

MAC Address: 00:95:69:a3:cc:9d

DMN31 IP Address: 0.0.0.0

DNS2 IP Address: 0.0.0.0

Save

2. Check Enable to enable the Wi-Fi function.
3. Input the hot spot name.
Or you can click Select... to select a network.
4. Input the Wi-Fi password.
5. (Optional) Click Refresh to refresh the network status.

57



Video Access Control Terminal-User Manual

6. (Optional) Select the NIC Type.
7. (Optional) Select to uncheck Enable DHCP and set the IP address, the subnet mask, the default

gateway, the MAC address, the DNS1 IP Address, and the DNS2 IP address.
8. Click Save to save the settings.

Configuring Wireless Dail Status

Steps:
1. Click Network -> Wireless Dial.

Dial Status
Real-Time Mode:
UIM Status:
Signal Quality:
Dial Status:

IP Address:
Subnet Mask:
Default Gateway:
DMS Address:

Refresh Connect

2. Edit the dial status, including the real-time mode, the UIM status, the signal quality, the dial
status, the IP address, the subnet mask the default gateway and the DNS address.

3. Click Conenct to start connecting.
Or click Refresh to refresh the status.

Configuring HDD Parameters

Steps:
1. Click Storage -> General.
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HDD Mo. | Capacity(GB) | Free Space(GB) Status Type HDD Group ... | Property
1 2889 28.67 Mormal Local Group0d Read/Write
Maodify Format Update
Progress:
0%
Storage Mode: Auto ol
0K

2. Check the HDD (SD card) No., capacity, the free space, the status and so on.

You can also edit and format the HDD (SD card). Or click Update to refresh the data.
3. Select the storage mode.
4. Click Save to save the settings.

Configuring Relay Parameters

Steps:
1. Click Alarm -> Relay.
You can view the relay parameters.

Relay Mame Qutput Delay(s) Zone Linkage Settings

1 3 Mone Fd

2. Click the & to pop up the Relay Parameters Settings window.
Set the relay name and the output delay.
4. Click Save to save the paramters.

Or click Copy to... to copy the relay information to other relays.

w

Configuring Access Control Parameters

Steps:

In the Remote Configuration interface, click Other -> Access Control Parameters. Check
Superimposed user information, Enable voice prompts, Upload picture to capture whether the
linkage, Save Linked Captured Pictures, Whether to allow key input card number, Enable WiFi
detect, and Enable 3G/4G. Click Save to save the settings.

59



Video Access Control Terminal-User Manual

Superimposed User Information

Enable Voice Prompts i
Lipload Picture for Linkage Capture

Save Linked Caputuring Picture

Press Keyboard to Enter Card Mo.

Enable Wi-Fi Probe

Enable 3G/4G

Save

Uploading Background Picture

Click Other -> Picture Upload. Click |~ to select the picture from the local. You can also click Live
View to preview the picture. Click Picture Upload to upload the picture.
Note: The function should be supported by the device.

Picture Name:

Preview

Delete Upload

Configuring Face Detection Parameters

Click Other -> Face Detection. You can check the Enable checkbox to enable the device face
detection function.
After you enable the function, the device should detect the face while authenticating. Or the
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authentication will be failed.
Note: Only devices with video function support this function.

Enable

Save

Configuring Video and Audio Parameters

You can set the video compression parameters.
Steps:
1. Click Image -> Video & Audio.

Camera: Cameral v
Video
Stream Type: Main Stream v Video Type: Video & Audio v
Bitrate Type: Constant v Bitrate: 2048 Kbps| ~
Video Quality. Medium Resolution: 1080P(1920%1080) v
Frame Type: P v Frame Rate: 25fps v
| Frame Interval: 25 - | Audio Encoding Type: G711 U v
Video Encoding Type: STD_H264 b

File Size Per Day. 21.0G

Copyto... Save

2. Select a camera in the drop-down list.

3. Set the camera video parameters, including the stream type, the bitrate type, the video quality,
the frame type, the | frame type, the video encoding type, the video type, the bitrate, the
resolution, the frame rate and the audio encoding type.

4. Click Save to save the settings.

Or click Copy to... to copy the parameters to other cameras.

Configuring Video Image Parameters

You can set the camera mode, brightness, contrast, saturation, hue, and sharpness.
Steps:
1. Click Image -> Image Settings.
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Configuring the Video Parameters of the Camera

Camera: Camera1 |'v

Mode A: Standard B
Brightness: ——
Contrast: ————
Saturation: ——
Hue: ——
Sharpness: ———

Default Value

2. Select a camera in the dropdown list.
3. Set the camera mode, brightness, contrast, saturation, hue, and sharpness.
Or click Default Value to set the parameters to the default values.

Configuring Volume Input and Output

Click Image -> Volume Input/Output. You can set the volume input and output. Click Save to save
the settings.

62



Video Access Control Terminal-User Manual

Volume Input

Volume |r|p|_|t — 10
Volume Qutput

Gutput Volume: s 10

Save

Operating Relay

Steps:
1. Click Operation -> Relay.
You can view the relay status.
2. Check the relay checkbox
Click Open or Close to open/close the relay.
4. (Optional) Click Refresh to refresh the relay status.

w

Open Close Refresh

Relay Mo. Name Status

1 Close

Viewing Relay Status

Click Status -> Relay to view the relay status.

Relay Status

Relayl Close

7.5 Organization Management

You can add, edit, or delete the organization as desired.

Click E tab to enter the Person and Card Management interface.

7. 5. 1 Adding Organization

Steps:
1. Inthe organization list on the left, you should add a top organization as the parent organization
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of all organizations.
Click Add button to pop up the adding organization interface.

Add Organization

Organization: [| |

0K Cancel

2. Input the Organization Name as desired.
Click OK to save the adding.
4. You can add multiple levels of organizations according to the actual needs.
To add sub organizations, select the parent organization and click Add.
Repeat Step 2 and 3 to add the sub organization.
Then the added organization will be the sub-organization of the upper-level organization.
Note: Up to 10 levels of organizations can be created.

w

7. 5. 2Modifying and Deleting Organization

You can select the added organization and click Modify to modify its name.

You can select an organization, and click Delete button to delete it.

Notes:
The lower-level organizations will be deleted as well if you delete an organization.
Make sure there is no person added under the organization, or the organization cannot be
deleted.

7.6 Person Management

After adding the organization, you can add person to the organization and manage the added
person such as issuing cards in batch, importing and exporting person information in batch, etc.
Note: Up to 10,000 persons or cards can be added.

7. 6. 1 Adding Person

Adding Person (Basic Information)

Steps:
1. Select an organization in the organization list and click Add button on the Person panel to pop
up the adding person dialog.
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Add Person *

Person No.: 5

Person Name:

Gender: @ Male Female
Phone No.:

Date of Birth:  2017-068-30

&4

Place of Birth:

Email:
Upload Picture  Take Photo

& Details | & Permission [] Card Face Picture @ Fingerprint

1D Type: D ~ Country:

ID No.: City:

Job Title: Degree: Junior High Sch... |~
On Board Date: 2017-06-30 (2t Employment Durati._. 10 =
Linked Device: v
Room No.:

Address:

Remark:

OK Cancel

2. The Person No. will be generated automatically and is not editable.

3. Input the basic information including person name, gender, phone No., birthday details, and
email address.

4. Click Upload Picture to select the person picture from the local PC to upload it to the client.
Note: The picture should be in *.jpg format.

5. (Optional) You can also click Take Phone to take the person’s photo with the PC camera.

6. Click OK to finish adding.

Adding Person (Detailed Information)

Steps:

1. Inthe Add Person interface, click Details tab.
& Details | & Permission [] Card Face Picture @ Fingerprint
ID Type: D ~ Country:
ID No.: City:
Job Title Degree: Junior High Sch... |~
On Board Date: 2017-06-30 £t Employment Durati... 10 =
Linked Device: >
Room No.:
Address:

J

Remark:

2. Input the detailed information of the person, including person’s ID type, ID No., country, etc.,
according to actual needs.
Linked Device: You can bind the indoor station to the person.
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Note: If you select Analog Indoor Station in the Linked Device, the Door Station field will
display and you are required to select the door station to communicate with the analog
indoor station.

Room No.: You can input the room No. of the person.

3. Click OK to save the settings.

Adding Person (Permission)

You can assign the permissions (including operation permissions of access control device and
access control permissions) to the person when adding person.

Note: For setting the access control permission, refer to Chapter 7.8 Permission Configuration.
Steps:

1.

4,

In the Add Person interface, click Permission tab.

£ Details & Permission Card Face Picture @ Fingerprint

Device Operation R...  Normal User v
Permission(s) to Select Selected Permission(s)
Permission Group 1

Permission Group 2
==

In the Device Operation Role field, select the role of operating the access control device.
Normal User: The person has the permission to check-in/out on the device, pass the access
control point, etc.

Administrator: The person has the normal user permission, as well as permission to configure
the device, including adding normal user, etc.

In the Permission(s) to Select list, all the configured permissions display.

Check the permission(s) checkbox(es) and click > to add to the Selected Permission(s) list.
(Optional) You can click >> to add all the displayed permissions to the Selected Permission(s)
list.

(Optional) In the Selected Permission(s) list, select the selected permission and click < to
remove it. You can also click << to remove all the selected permissions.

Click OK to save the settings.

Adding Person (Card)

You can add card and issue the card to the person.
Steps:

1.

In the Add Person interface, click Card tab.
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i3 Details & Permission [©] Card Face Picture @ Fingerprint

Add Modify X Delete %alink.. % QR.. Link ...

Index | Card No. | Card Type | Card Effective ... |Link Fingerprint Link Face P

2. Click Add to pop up the Add Card dialog.

Add Card x
Card Type: Mormal Card ~
Card Password:
Effective Period:  From 2017-01-18[ZL  To 2027-01-18 [£1
@ Access Controller ... e
ad
Card Reader Mode: Card Enroliment S... | Set Card Enroliment Station
Manually Input Enter
Index Card Mo. Card Type Card Effective Period
oK Cancel

3. Select the card type according to actual needs.
Normal Card
Card for Door Extended Opening: The door will remain open for the configured time
period for the card holder.
Card in Blocklist: The card swiping action will be uploaded and the door cannot be opened.
Patrol Card: The card swiping action can used for checking the working status of the
inspection staff. The access permission of the inspection staff is configurable.
Duress Card: The door can open by swiping the duress card when there is duress. At the
same time, the client can report the duress event.
Super Card: The card is valid for all the doors of the controller during the configured
schedule.
Visitor Card: The card is assigned for visitors. For the Visitor Card, you can set the Max.
Swipe Times.
Note: The Max. Swipe Times should be between 0 and 255. When setting as O, it means
the card swiping is unlimited.

4. Input the password of the card itself in the Card Password field. The card password should

contain 4 to 8 digits.
Note: The password will be required when the card holder swiping the card to get enter to or
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exit from the door if you enable the card reader authentication mode as Card and Password,
Password and Fingerprint, and Card, Password, and Fingerprint. For details, refer to Chapter
7.9.2 Card Reader Authentication.
5. Click £ to set the effective time and expiry time of the card.
6. Select the Card Reader Mode for reading the card No.
Access Controller Reader: Place the card on the reader of the Access Controller and click
Read to get the card No.
Card Enrollment Station: Place the card on the Card Enrollment Station and click Read to
get the card No.
Note: The Card Enrollment Station should connect with the PC running the client. You can
click Set Card Enrollment Station to enter the following dialog.

Card Enrollment Station *

Type: DS-K1F100-D8 &
Connection Mode: USB

Timeout after: 500 ms
Buzzing: ® Yes No
Card No. Type: Mormal

M1 Card Encryption: Enable
Select Sector: Selected 0/32 Modify

Restore Default Value: Save

1) Select the Card Enrollment Station type.
Note: Currently, the supported card reader types include DS-K1F100-D8, DS-K1F100-M,
DS-K1F100-D8E, and DS-K1F180-D8E.
2) Set the serial port No., the baud rate, the timeout value, the buzzing, or the card No.
type.
3) Click Save button to save the settings.
You can click Restore Default Value button to restore the defaults.
Manually Input: Input the card No. and click Enter to input the card No.
7. Click OK and the card(s) will be issued to the person.
8. (Optional) You can select the added card and click Modify or Delete to edit or delete the card.
9. (Optional) You can generate and save the card QR code for QR code authentication.
1) Select an added card and click QR Code to generate the card QR code.
2) Inthe QR code pop-up window, click Download to save the QR code to the local PC.
You can print the QR code for authentication on the specified device.
Note: The device should support the QR code authentication function. For details about
setting the QR code authentication function, see the specified device user manual.
10. (Optional) You can click Link Fingerprint to link the card with the person’s fingerprint, so that
the person can place the finger on the scanner instead of swiping card when passing the door.
11. (Optional) You can click Link Face Picture to link the card with the face picture, so that the
person can pass the door by scanning the face via the device instead of swiping card when
passing the door.
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12. Click OK to save the settings.

Adding Person (Fingerprint)

Steps:
1. Inthe Add Person interface, click Fingerprint tab.

Collection Mode: @ Local Collection Remote Collecti...

getiir)gerprirlt Ma - Start

elete

(w ]

Fingerprint Quality S—— =

Note: Click Start to start collecting the fingerprint.

The fingerprint is collected. Click OK on the Add Person interface to confirm
collecting the fingerprint.

2. Select Local Collection as desired.

3. Before inputting the fingerprint, you should connect the fingerprint machine to the PC and set
its parameters first.
Click Set Fingerprint Machine to enter the following dialog box..

Fingerprint Machine x

Device Type: |DS—K1F820—F ...|

Restore Default Value Save

1) Select DS-K1F820-F as the device type.

2) Click Save button to save the settings.
You can click Restore Default Value button to restore the default settings.

Notes:
The serial port number should correspond to the serial port number of PC. You can check
the serial port number in Device Manager in your PC.
The baud rate should be set according to the external fingerprint card reader. The default
value is 19200.
Timeout after field refers to the valid fingerprint collecting time. If the user does not input
a fingerprint or inputs a fingerprint unsuccessfully, the device will indicate that the
fingerprint collecting is over.

4. Click Start button, click to select the fingerprint to start collecting.
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8.

Lift and rest the corresponding fingerprint on the fingerprint scanner twice to collect the
fingerprint to the client.

(Optional) You can also click Remote Collection to collect fingerprint from the device.

Note: The function should be supported by the device.

(Optional) You can select the registered fingerprint and click Delete to delete it.

You can click Clear to clear all fingerprints.

Click OK to save the fingerprints.

Importing and Exporting Person Information

The person information can be imported and exported in batch.
Steps:

1.

Exporting Person: You can export the added persons’ information in Excel format to the local

PC.

1) After adding the person, you can click Export Person button in the Person and Card tab to
pop up the following dialog.

2) Click - to select the path of saving the exported Excel file.

3) Check the checkboxes to select the person information to export.

Export Person »

Saving Path o..
Mote: The operation will export all the existing persons.
~ Person No
~ Organization
~ MName
~ Gender
~ ID Type

~ ID No

~/ Date of Birth

~ Phone No

~ lob Title

~ Address

~ Email

4 Connbne

OK Cancel

4) Click OK to start exporting.

Importing Person: You can import the Excel file with persons information in batch from the
local PC

1) click Import Person button in the Person and Card tab.

Import Person x
FPlease selectthe file to import.

Impaort File:

Download Template for Importing Person

OK Cancel

2) You can click Download Template for Importing Person to download the template first.
3) Input the person information to the downloaded template.
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4) Click - to select the Excel file with person information.
5) Click OK to start importing.

Getting Person Information from Access Control Device

If the added access control device has been configured with person information (including person
details, fingerprint, issued card information), you can get the person information from the device
and import to the client for further operation.

Note: This function is only supported by the device the connection mothod of which is TCP/IP
when adding the device.

Steps:

1. Inthe organization list on the left, click to select an organization to import the persons.

2. Click Get Person button to pop up the following dialog box.

Select Device x

Nickname IP
10.18.146.86 10.18.146.86
1016.6.112 1016.6.112

1016.6.111 1016.6.111

Mote: If the person has already been added to other department, he/she will be deleted
from the other department.

OK Cancel

3. The added access control device will be displayed.

4. Click to select the device and then click OK to start getting the person information from the
device.
You can also double click the device name to start getting the person information.

Notes:
The person information, including person details, person’s fingerprint information (if
configured), and the linked card (if configured), will be imported to the selected organization.
If the person name stored in the device is empty, the person name will be filled with the issued
card No. after importing to the client.
The gender of the persons will be Male by default.
Up to 10000 persons can be imported.

7. 6. 2Managing Person

Modifying and Deleting Person

To modify the person information and attendance rule, click or in the Operation column,
or select the person and click Modify to open the editing person dialog.

You can click B2 to view the person’s card swiping records.

To delete the person, select a person and click Delete to delete it.
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Note: If a card is issued to the current person, the linkage will be invalid after the person is deleted.

Changing Person to Other Organization

You can move the person to another organization if needed.

Steps:

1. Select the person in the list and click Change Organization button.

Change Organization

Organization: |test2 v|

OK Cancel

2. Select the organization to move the person to.
3. Click OK to save the settings.

Searching Person

You can input the keyword of card No. or person name in the search field, and click Search to
search the person.

You can input the card No. by clicking Read to get the card No. via the connected card enrollment
station.

You can click Set Card Enrollment Station in the dropdown list to set the parameters.

7. 6. 3lIssuing Card in Batch

You can issue multiple cards for the person with no card issued in batch.
Steps:
1. Click Issue Card in Batch button to enter the following dialog.
All the added person with no card issued will display in the Person(s) with No Card Issued list.
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Issue Card in Batch x

Card Type Normal Card ~
Card Password:

Card Quantity: 1

Effective Period From 2017-01-18[% To 2027-01-18 [

® Access Confroller Reader ~
Read
Card Reader Mode: Card Enroliment Station Set Card Enrollment Station

Manually Input Enter
Personis) with Mo Card Issued Person(s) with Card Issued
Person Name | Gender Department Person Mame | Card No. Gender Departn

Wendy Female Department 1

Cindy Female Department 1/5ub Depar...

OK Cancel

Select the card type according to actual needs.
Note: For details about the card type, refer to Adding Person.
Input the password of the card itself in the Card Password field. The card password should
contain 4 to 8 digits.
Note: The password will be required when the card holder swiping the card to get enter to or
exit from the door if you enable the card reader authentication mode as Card and Password,
Password and Fingerprint, and Card, Password, and Fingerprint. For details, refer to Chapter
7.9.2 Card Reader Authentication.
Input the card quantity issued for each person.
For example, if the Card Quantity is 3, you can read or enter three card No. for each person.
Click X to set the effective time and expiry time of the card.
In the Person(s) with No Card Issued list on the left, select the person to issue card.
Note: You can click on the Person Name, Gender, and Department column to sort the persons
according to actual needs.
Select the Card Reader Mode for reading the card No.
Access Controller Reader: Place the card on the reader of the Access Controller and click
Read to get the card No.
Card Enrollment Station: Place the card on the Card Enrollment Station and click Read to
get the card No.
Note: The Card Enrollment Station should connect with the PC running the client. You can
click Set Card Enrollment Station to enter the following dialog.
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Card Enroliment Station x

Type: DS-K1F100-D8 |~
Connection Mode: USB

Timeout after: 500 ms
Buzzing 2 Yes No

Card Mo. Type: Mormal ©

Restore Default Value Save

1) Select the Card Enrollment Station type.
Note: Currently, the supported card reader types include DS-K1F100-D8, DS-K1F100-M,
DS-K1F100-D8E, and DS-K1F180-D8E.
2) Set the parameters about the connected card enroliment station.
3) Click Save button to save the settings.
You can click Restore Default Value button to restore the defaults.
Manually Input: Input the card No. and click Enter to input the card No.
8. After issuing the card to the person, the person and card information will display in the
Person(s) with Card Issued list.
9. Click OK to save the settings.

7.7 Schedule and Template

Purpose:
You can configure the template including week schedule and holiday schedule. After setting the
templates, you can adopt the configured templates to access control permissions when setting the
permission, so that the access control permission will take effect in the time durations of the
template.

Click Eé to enter the schedule and template interface.
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,_'] Blank Template

[@ wWeek Schedule ] Holiday Group [~ Template
Add Week Delete W. Property I sae
Search... o]

Week Schedule ...

VWhole Week Schedule

In Whole Week Schedule, the card swiping is valid in each

Remark: day of the week. It cannot be edited or deleted

Copyto .. # Delete D... T Clear
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You can manage the schedule of access control permission including Week Schedule, Holiday
Schedule, and Template. For permission settings, please refer to Chapter 7.8 Permission
Configuration.

7.7.1 Week Schedule

Click Week Schedule tab to enter the Week Schedule Management interface.
The client defines two kinds of week plan by default: Whole Week Schedule and Blank Schedule,
which cannot be deleted and edited.
Whole Week Schedule: Card swiping is valid on each day of the week.
Blank Schedule: Card swiping is invalid on each day of the week.
You can perform the following steps to define custom schedules on your demand.
Steps:
1. Click Add Week Schedule button to pop up the adding schedule interface.

Add Week Schedule x

Week Schedule Name:

2. Input the name of week schedule and click OK button to add the week schedule.

3. Select the added week schedule in the schedule list and you can view its property on the right.
You can edit the week schedule name and input the remark information.

4. On the week schedule, click and drag on a day to draw on the schedule, which means in that

Cancel
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period of time, the configured permission is activated.
Note: Up to 8 time periods can be set for each day in the schedule.
5. When the cursor turns to l"!, you can move the selected time bar you just edited. You can also
edit the displayed time point to set the accurate time period.
When the cursor turns to E&=3, you can lengthen or shorten the selected time bar.
6. Optionally, you can select the schedule time bar,
and then click Delete Duration to delete the selected time bar,
or click Clear to delete all the time bars,
or click Copy to Week to copy the time bar settings to the whole week.
7. Click Save to save the settings.

7. 7. 2Holiday Group

Click Holiday Group tab to enter the Holiday Group Management interface.

| Week Schedule i~ Holiday Group | =] Template
Add Holi... Delete H... Property K save
Search P
_ Holiday Group: Holiday Group 1
Remark:
Holiday List Add Holiday Prev Page Mext Page
Index Start Date End Date Duration Operation
1 2017—01—U1ﬂ 2017—01—03& n 2 d -] a 12 1d 1k 18 20 22 24 ﬁ 5
Steps:
1. Click Add Holiday Group button on the left to pop up the adding holiday group interface.
Add Holiday Group x

Holiday Group Mame: [Long Holidaﬂ ]

OK Cancel

2. Input the name of holiday group in the text filed and click OK button to add the holiday group.
3. Select the added holiday group and you can edit the holiday group name and input the remark
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information.

4. Click Add Holiday icon on the right to add a holiday period to the holiday list and configure the
duration of the holiday.
Note: Up to 16 holidays can be added to one holiday group.

Haliday List Add Holiday Prev Page Next Page

Serial No. | Start Date End Date Duration Operation

o 2 4 ] 2 w12 1 1 1@ 20 22 2o
! yor0te [ 302016 [ pee—— ®

o 2 4 ] 2 w12 14 16 1@ 20 22 2
2 zae0s [ 201206 [ i —— %

1) On the period schedule, click and drag to draw the period, which means in that period of
time, the configured permission is activated.
Note: Up to 8 time durations can be set for each period in the schedule.
2) When the cursor turns to ﬂ, you can move the selected time bar you just edited. You can
also edit the displayed time point to set the accurate time period.
3) When the cursor turns to B&3, you can lengthen or shorten the selected time bar.
4) Optionally, you can select the schedule time bar,
and then click to delete the selected time bar,
or click to delete all the time bars of the holiday,
orclick * to delete the holiday directly.
5. Click Save to save the settings.
Note: The holidays cannot be overlapped with each other.

7. 7. 3Template

After setting the week schedule and holiday group, you can configure the template which contains

week schedule and holiday group schedule.
Note: The priority of holiday group schedule is higher than the week schedule.
Click Template tab to enter the Template Management interface.
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Add Temp Delete T Property

Search... o)
|| Whole Week Template

|7 Blank Template

J Week Schedule § | Holiday Group E Template

H save

Template Name: Template 1

Remark:

|m week Schedule || Holiday Group

Week Schedule  \Whole Week Schedule ~ o= Add Week...

Mon

Tue

Wed

Thu

Fri

Sat

Sun

o 2 4 6 g 10 12 14 16 18 20 22 24
s O
1] £ 4 6 g 10 12 14 16 18 20 22 24
O O
o £ 4 3 8 10 12 14 16 18 20 22 24
|
1] B 4 3 8 10 12 14 16 18 20 22 24

There are two pre-defined templates by default: Whole Week Template and Blank Template,

which cannot be deleted and edited.

Whole Week Template: The card swiping is valid on each day of the week and it has no holiday

group schedule.

Blank Template: The card swiping is invalid on each day of the week and it has no holiday

group schedule.

You can define custom templates on your demand.

Steps:

1. Click Add Template to pop up the adding template interface.

2. Input the template name in the text filed and click OK button to add the template.
3. Select the added template and you can edit its property on the right. You can edit the template

Add Template x

Template Name:

name and input the remark information.
4. Select a week schedule to apply to the schedule.
Click Week Schedule tab and select a schedule in the dropdown list.

You can also click Add Week Schedule to add a new week schedule. For details, refer to

Chapter 7.7.1 Week Schedule.
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5. Select holiday groups to apply to the schedule.
Note: Up to 4 holiday groups can be added.

| Week Schedule [[-| Holiday Group

Holiday Group to Select Selected Holiday Group

Add Holi...

Index Heliday Group Name

Search... o

1

Holiday Group 1

& Add

# Delete

fir Clear

Remark

Click to select a holiday group in the list and click Add to add it to the template. You can also
click Add Holiday Group to add a new one. For details, refer to Chapter 7.7.2 Holiday Group.
You can click to select an added holiday group in the right-side list and click Delete to delete it.

You can click Clear to delete all the added holiday groups.
6. Click Save button to save the settings.

7.8 Permission Configuration

In Permission Configuration module, you can add, edit, and delete the access control permission,

and then apply the permission settings to the device to take effect.

Click E icon to enter the Access Control Permission interface.

4 Add [ Modify X Delete (& Apply All (5 Apply Changes
Permission Na... Template Person Door Details
Permission 1 Whole Week T... Wendy Floorl_10.17... Details

Status
Not Applied
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7. 8. 1 Adding Permission

Purpose:

You can assign permission for persons to enter/exist the access control points (doors) in this
section.

Notes:

You can add up to 4 permissions to one access control point of one device.
You can add up to 128 permissions in total.

Steps:

1.

Click Add icon to enter following interface.

Add Permission x

Permission Name U‘I’h\s is an example ]
Template: Whole Week Template ~ | Add Template
Person Selected Person
Search... o] Search.. P
= # Department 01 PersonMame | Organization
& Wendy
,& Yining =
h\ test =
Access Control PointDevice Selected Access Control PointDevice
Search... o] Search.. P
10166112 Access Contro_.. | Door Group
10.18.146.86
10166111 >
&8 Door Station =
OK Cancel

In the Permission Name field, input the name for the permission as desired.

Click on the dropdown menu to select a template for the permission.

Note: You should configure the template before permission settings. You can click Add
Template button to add the template. Refer to Chapter 7.7 Schedule and Template for details.
In the Person list, all the added persons display.

Check the checkbox(es) to select person(s) and click > to add to the Selected Person list.
(Optional) You can select the person in Selected Person list and click < to cancel the selection.
In the Access Control Point/Device list, all the added access control points (doors) and door
stations will display.

Check the checkbox(es) to select door(s) or door station(s) and click > to add to the selected
list.

(Optional) You can select the door or door station in the selected list and click < to cancel the
selection.

Click OK button to complete the permission adding. The selected person will have the
permission to enter/exit the selected door/door station with their linked card(s) or fingerprints.
(Optional) after adding the permission, you can click Details to modify it. Or you can select the
permission and click Modify to modify.
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You can select the added permission in the list and click Delete to delete it.

7. 8. 2 Applying Permission

Purpose:
After configuring the permissions, you should apply the added permission to the access control
device to take effect.
Steps:
1. Select the permission(s) to apply to the access control device.
To select multiple permissions, you can hold the Ctr/ or Shift key and select permissions.
2. Click Apply All to start applying all the selected permission(s) to the access control device or
door station.
You can also click Apply Changes to apply the changed part of the selected permission(s) to the

device(s).
3. The following window will pop up, indicating the applying permission result.
Application Result x
Applying Permission Settings Progress: Applying (100%)
I 100%
Filter
Name Progress | Result Remark
- Permission Group 2
172.10.18.69 100% Applied
Close
Notes:

When the permission settings are changed, the following hint box will pop up.

Data Synchronization

Data is changed.Click Apply Now to apply the
updated data to the devices.Or you can apply it
to devices later in Permission interface.

Apply Now Apply Later
You can click Apply Now to apply the changed permissions to the device.
Or you can click Apply Later to apply the changes later in the Permission interface.
The permission changes include changes of schedule and template, permission settings,
person’s permission settings, and related person settings (including card No., fingerprint, face
picture, linkage between card No. and fingerprint, linkage between card No. and fingerprint,
card password, card effective period, etc).

81



Video Access Control Terminal-User Manual

7.9 Advanced Functions

Purpose:

After configuring the person, template, and access control permission, you can configure the
advanced functions of access control application, such as access control parameters,
authentication password, and opening door with first card, anti-passing back, etc.

Note: The advanced functions should be supported by the device.

Click ﬁ icon to enter the following interface.

Access Conirol Params | Card Reader Authentication Multiple Authentication Open Door with First Card Anti-passing Back Multi-door Interlocking Authentication Password

Controller List Card Reader Information: H sawe
Search... Nickname:
*+ (& 10.166.222 Enable Card Reader: Yes
OK LED Polarity: |Cathode
Error LED Polarity: | Cathode
Buzzer Polarity: |Cathode
Minimum Card Swiping Interval:
Max. Interval When Inputting Password:
Enable Failed Attempts Limit of Card Readi... |Yes
Max Times of Card Swiping Failure:
Enable Tampering Detection: |Yes

Detect When Card Reader is Offline for:

7.9. 1 Access Control Parameters

Purpose:

After adding the access control device, you can configure its access control point (door)’s
parameters, and its card readers’ parameters.

Click Access Control Parameters tab to enter the parameters settings interface.

Door Parameters

Steps:
1. In the controller list on the left, click '*' to expand the access control device, select the door
(access control point) and you can edit the information of the selected door on the right.
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Controller List Door Information: E save

Search... o Door Magnetic. Remain Closed o

= & Video Access Control Terminal Exit Button Type: Remain Open &

™

“@ Entrance Card Readerl
Door Open Duration by Card for Disabled P... 15 g

“@ Exit Card Reader2
Door Open Timeout Alarm: 30 s
Enable Locking Doorwhen Door Closed: Yes v

Duress Code:

Super Password:

2. You can editing the following parameters:
Door Magnetic: The Door Magnetic is in the status of Remain Closed (excluding special
conditions).
Exit Button Type: The Exit Button Type is in the status of Remain Open (excluding special
conditions).
Door Locked Time: After swiping the normal card and relay action, the timer for locking
the door starts working.
Door Open Duration by Card for Door Extended Opening: The door magnetic can be
enabled with appropriate delay after card holder swipes the card.
Door Open Timeout Alarm: The alarm can be triggered if the door has not been close
Enable Locking Door when Door Closed: The door can be locked once it is closed even if
the Door Locked Time is not reached.
Duress Code: The door can open by inputting the duress code when there is duress. At the
same time, the client can report the duress event.
Super Password: The specific person can open the door by inputting the super password.
Notes:
The duress code and Super password should be different.
The duress code and the super password should be different from the authentication
password.
The duress code and super password should contain 4 to 8 numerics.
3. Click Save button to save parameters.

Card Reader Parameters

Steps:
1. Inthe device list on the left, click to expand the door, select the card reader name and you
can edit the card reader parameters on the right.

o+

83



Video Access Control Terminal-User Manual

Controller List Card Reader Information: H Save

o] Basic Information

Search...

= le Video Access Control Terminal Rickaapesy Eniance Card Readerd

= Doorl Enable Card Reader: Yes -
“H Bt Card Reader? Error LED Polarity: Anode =

Buzzer Polarity:  Anode -
Minimum Card Swiping Interval: 0 s
Max. Interval When Inputting Password: 10 s

Enable Failed Attempts Limit of Card Readi_. Mo v

Max Times of Card Swiping Failure: 5

Enable Tampering Detection: Mo »
Detect When Card Reader is Offline for. 22 5
Buzzing Time: 0 5

Card Reader Type: Fingerprint
Card Reader Description: DS-K1T501SF
Fingerprint

Fingerprint Recognition Level: 1/100000False Acceptance Rate . |~

2. You can editing the following parameters:
Nickname: Edit the card reader name as desired.
Enable Card Reader: Select Yes to enable the card reader.
OK LED Polarity: Select the OK LED Polarity of the card reader mainboard.
Error LED Polarity: Select the Error LED Polarity of the card reader mainboard.
Buzzer Polarity: Select the Buzzer LED Polarity of the card reader mainboard.
Minimum Card Swiping Interval: If the interval between card swiping of the same card is
less than the set value, the card swiping is invalid. You can set it as O to 255.
Max. Interval When Inputting Password: When you inputting the password on the card
reader, if the interval between pressing two digits is larger than the set value, the digits
you pressed before will be cleared automatically.
Enable Failed Attempts Limit of Card Reading: Enable to report alarm when the card
reading attempts reach the set value.
Max. Times of Card Swiping Failure: Set the max. failure attempts of reading card.
Enable Tampering Detection: Enable the anti-tamper detection for the card reader.
Detect When Card Reader is Offline for: When the access control device cannot connect
with the card reader for longer than the set time, the card reader will turn offline
automatically.
Buzzing Time: Set the card reader buzzing time. The available time ranges from 0 to 5999s.
0 represents continuous buzzing.
Card Reader Type: Get the card reader’s type.
Card Reader Description: Get the card reader description.
Fingerprint Recognition Level: Select the fingerprint recognition level in the dropdown list.
By default, the level is Low.

3. Click the Save button to save parameters.
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7. 9. 2Card Reader Authentication

Purpose:
You can set the passing rules for the card reader of the access control device.
Steps:
1. Click Card Reader Authentication tab and select a card reader on the left.
2. Click Configuration button to select the card reader authentication modes for setting the
schedule.
Notes:
The available authentication modes depend on the device type.
Password refers to the card password set when issuing the card to the person in Chapter
7.6 Person Management.
1) Select the modes and click | » | to add to the selected modes list.
Youcanclick I or | toadjustthe display order.

Config Reader Authentication Mode x

Optional modes:
Card
Card and Password

Card Or Authentication Passwo...

P

§ \ «
Fingerprint

Selected modes:

Card and Password
Card

Fingerprint

Card and Fingerprint

- =5 =

Password and Fingerprint Card Or Authentication Pakswio...

Card Or Fingerprint - Password and Fingerprint| | -

Cancel

2) Click OK to confirm the selection.

3. After selecting the modes, the selected modes will display as icons.
Click the icon to select a card reader authentication mode.

4. Click and drag your mouse on a day to draw a color bar on the schedule, which means in that
period of time, the card reader authentication is valid.

5.

Property
(Card Reader Name:

Tue

Wed

~ Copyto K Save

Entrance Card Reader1

(Card Reader Authentication Mode:

Authentication ... Configuration
Card Fingerprint Card and Face Face
(Card Reader Authentication Week Schedule Settings Copy to Week Delete B Clear
0 2 4 6 ] 10 12 14 16 18 20 22 24

Thu N T M M

2] w
E )

Repeat the above step to set other time periods.
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Or you can select a configured day and click Copy to Week button to copy the same settings to
the whole week.
(Optional) You can click Delete button to delete the selected time period or click Clear button
to delete all the configured time periods.

6. (Optional) Click Copy to button to copy the settings to other card readers.

Select Card Reader x

Select Card Reader to Copy to:
Search P
(O
) 107.39.120_Doorl
10.7.39.120_Reader Out2
= 10.7.39.120_Door2
10.7.39.120_Reader In3
10.7.39.120_Reader Qutd
= 10.7.39.120_Door3
10.7.39.120_Reader In5
10.7.39.120_Reader Outb
= 107.39.120 Doord
10.7.39.120_Reader In7
10.7.39.120_Reader QutB
OK Cancel

7. Click Save button to save parameters.

7. 9. 3 Multiple Authentication

Purpose:

You can manage the cards by group and set the authentication for multiple cards for one access
control point (door).

Note: Please set the card permission and apply the permission setting to the access control device
first. For details, refer to Chapter 7.8 Permission Configuration.

Steps:

1. Click Multiple Authentication tab to enter the following interface.

86



Video Access Control Terminal-User Manual

Contraller List Set Card Group I save
Search P Add Modif Delete
[ 2 A" Cord Group Mermber Detsic

Set Authentication Group
Access Conltrol Point Door1| v Time Internal 30 s Add ModiF Delete

Linked Door Template Authentication Type Offline Authentication Auth

2. Select access control device from the list on the left.
3. Inthe Set Card Group panel on the right, click Add button to pop up the following dialog:

Add x
Card Group Mame
Effective Period 2017-01-12 00:00:00 ﬂo 2017-01-12 23:59:58 ﬂ
Card Group Member | - Yining
13345667
OK Cancel

1) Inthe Card Group Name field, input the name for the group as desired.
2) Click £ to set the effective time and expiry time of the card group.
3) Check the checkbox(es) to select the card(s) to add the card group.
4) Click OK to save the card group.
4. Inthe Set Authentication Group panel, select the access control point (door) of the device for
multiple authentications.
5. Input the time interval for card swiping.
6. Click Add to pop up the following dialog.
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Add x

Access Control Point:  Door »
Time Internal: a0

Template: Whole Week Template ~
Authentication Type: Local Authentication )

Offline Authentication: Enable Super Password W

Group3 Groupl 1

Group2 2

Remark:Follow the
configured order to
swipe the card to
authenticate

OK Cancel

1) Select the template of the authentication group from the dropdown list. For details about
setting the template, refer to Chapter 7.7 Schedule and Template.

2) Select the authentication type of the authentication group from the dropdown list.
Local Authentication: Authentication by the access control device.
Local Authentication and Remotely Open Door: Authentication by the access control
device and by the client.
For Local Authentication and Remotely Open Door type, you can check the checkbox
to enable the super password authentication when the access control device is
disconnected with the client.

Local Authentication and Super Password: Authentication by the access control
device and by the super password.
3) Inthe list on the left, the added card group will display. You can click the card group and
click to add the group to the authentication group.
You can click the added card group and click * to remove it from the authentication

group.
You can also click or to set the card swiping order.
4) Input the Card Swiping Times for the selected card group.
Notes:

The Card Swiping Times should be larger than 0 and smaller than the added card
quantity in the card group.
The upper limit of Card Swiping Times is 16.
5) Click OK to save the settings.
7. Click Save to save and take effect of the new settings.
Notes:
For each access control point (door), up to 20 authentication groups can be added.
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For the authentication group which certificate type is Local Authentication, up to 8 card
groups can be added to the authentication group.

For the authentication group which certificate type is Local Authentication and Super
Password or Local Authentication and Remotely Open Door, up to 7 card groups can be
added to the authentication group.

7.9. 40pen Door with First Card

Purpose:
You can set multiple first cards for one access control point. After the first card swiping, it allows
multiple persons access the door or other authentication actions. The first card mode contains
Remain Open with First Card, and Disable Remain Open with First Card.
Remain Open with First Card: The door remains open for the configured time duration after
the first card swiping until the remain open duration ends.
Disable Remain Open with First Card: Disable the function.
Notes:
The first card authorization is effective only on the current day. The authorization will be
expired after 24:00 on the current day.
You can swipe the first card again to disable the first card mode.

Steps:

1. Click Open Door with First Card tab to enter the following interface.
Controller List Door Open by First Card Parameters H Save
Search... P | Access Control Paint First Card Mode Remain Open Duration (mins)
_ Doorl Disable Remain Openwith ... |~ 10

First Card List

Add Delete Filter
Card Ne. i Person Name Effective Date Expiry Date
Total:0 Page:11 Item Per Page: 100 L Page Goto

2. Select an access control device from the list on the left.

Select the first card mode in the drop-down list for the access control point.

4. (Optional) If you select Remain Open with First Card, you should set remain open duration.
Notes:

w
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The Remain Open Duration should be between 0 and 1440 minutes. By default, it is 10

You can swipe the first card again to disable the first card mode.

5. Inthe First Card list, Click Add button to pop up the following dialog box.

1)

2)

Selectthe card to add
Filter

Card No

12345667

776433245

Total:2 Page:1/1 ltem Per Page:

Add Card

Person Name

Yining

Wendy

Page

OK.

»

Goto

Cancel

Select the cards to add as first card for the door
Note: Please set the card permission and apply the permission setting to the access
control device first. For details, refer to Chapter 7.8 Permission Configuration.
Click OK button to save adding the card.

6. You can click Delete button to remove the card from the first card list.
7. Click Save to save and take effect of the new settings.

7. 9. 5 Anti-Passing Back

Purpose:
You can set to only pass the access control point according to the specified path and only one

person could pass the access control point after swiping the card.

Notes:
Either the anti-passing back or multi-door interlocking function can be configured for an access

control device at the same time.
You should enable the anti-passing back function on the access control device first.

Steps:

1. Click Anti-passing Back tab to enter the following interface.
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Controller List Property |;| Save

search...

First Card Read... Entrance Card Reader1

Index Card Reader Card Reader Afterward

Entrance Card Readerl ~ Entrance Card Reader3 Exit Card Readerd
Exit Card Reader2

Entrance Card Reader3

Exit Card Readerd

Entrance Card Reader3

Exit Card Readerd

Entrance Card Reader?

L T Y " A

Exit Card Reader8

2. Select an access control device from the device list on the left.

In the First Card Reader field, select the card reader as the beginning of the path.

4. Inthe list, click the text filed of Card Reader Afterward and select the linked card readers.
Example: If you select Reader In_01 as the beginning, and select Reader In_02, Reader Out_04
as the linked card readers. Then you can only get through the access control point by swiping
the card in the order as Reader In_01, Reader In_02 and Reader Out_04.

Select Card Reader x

w

Selectthe card reader:
Search o]
10.7.39.120_Reader In3
10.7.39.120_Reader Outd
10.7.39.120_Reader In5
10.7.39.120_Reader Outb
10.7.39.120_Reader InT
10.7.39.120_Reader Out8
OK Cancel

Note: Up to four afterward card readers can be added for one card reader.

5. (Optional) You can enter the Select Card Reader dialog box again to edit its afterward card
readers.

6. Click Save to save and take effect of the new settings.

7.10 Searching Access Control Event
Purpose:

You can search the access control history events including remote event and local event via the
client.

Local Event: Search the access control event from the database of the control client.
Remote Event: Search the access control event from the device.
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Click @ icon and click Access Control Event tab to enter the following interface.

Access Control Event| Call Log Unlacking Log  Natice

Event Source: ® Local Event Remote E.. Card Holder Information

Device: 172.10.18.81 ~ Event Type: All
Card Holder Name: ¥ Card No.-
Search
Organization: ~ Card Reader Type: All v
Start Time: 2017-06-26 00:00:00 [ End Time: 2017-06-26 23:59:59 i
Search Result Export

Serial No. | Event Type | Card Holder | Card Type | Card No. Event Time | Event Source Capture | Playback | Direction | MAC A
Person No -

Person Name:
Gender

ID Type:

ID No.:
Qrganization:

Phone No
Address:

Total:0 Page:1/1 Page Go

7.10.1 Searching Local Access Control Event

Steps:

1. Select the Event Source as Local Event.

2. Input the search condition according to actual needs.
3. Click Search. The results will be listed below.
4

For the access control event which is triggered by the card holder, you can click the event to
view the card holder details, including person No., person name, organization, phone number,
contact address and photo.

5. (Optional) If the event contains linked pictures, you can click in the Capture column to view the
captured picture of the triggered camera when the alarm is trigged.

6. (Optional) If the event contains linked video, you can click in the Playback column to view the
recorded video file of the triggered camera when the alarm is trigged.

Note: For setting the triggered camera, refer to Chapter 7.11.1 Access Control Event Linkage.

7. You can click Export to export the search result to the local PC in *.csv file.

7.10.2 Searching Remote Access Control Event

Steps:

1. Select the Event Source as Remote Event.
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2. Input the search condition according to actual needs.

3. (Optional) You can check With Alarm Picture checkbox to search the events with alarm
pictures.

4. Click Search. The results will be listed below.

5. You can click Export to export the search result to the local PCin *.csv file.

7.11 Access Control Event Configuration

Purpose:

For the added access control device, you can configure its access control linkage including access
control event linkage, access control alarm input linkage, event card linkage, and cross-device
linkage.

| < 8

Click the I icon on the control panel,
or click Tool->Event Management to open the Event Management page.

7.11.1 Access Control Event Linkage

Purpose:

You can assign linkage actions to the access control event by setting up a rule. For example, when

the access control event is detected, an audible warning appears or other linkage actions happen.

Note: The linkage here refers to the linkage of the client software’s own actions.

Steps:

1. Click the Access Control Event tab.

2. The added access control devices will display in the Access Control Device panel on the left.
Select the access control device, or alarm input, or access control point (door), or card reader
to configure the event linkage.

3. Select the event type to set the linkage.

4. Select the triggered camera. The image or video from the triggered camera will pop up when
the selected event occurs.

To capture the picture of the triggered camera when the selected event occurs, you can also set
the capture schedule and the storage in Storage Schedule.

5. Check the checkboxes to activate the linkage actions. For details, refer to Table 14.1 Linkage
Actions for Access Control Event.

6. Click Save to save the settings.

7. You can click Copy to button to copy the access control event to other access control device,
alarm input, access control point, or card reader.

Select the parameters for copy, select the target to copy to, and click OK to confirm.
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Access Control Device ol H sas
Search... p
— [1 Access Controller 01 Event Type: Trigger Camera: v
g Eventl + All " = Trigger Client ...
& Event2 ¥ Open Door with First Card Started ~ Audible Warning  Other Alarm Sound | ~
g Event3 + Open Door with First Card Stopped ~ Email Linkage
g Eventd | Remain Open Started | Alarm Triggere...
/& Events / Remain Open Stopped ¥ Alarm on E-map
& Eventb + Remain Closed Started
& Event? | Remain Closed Stopped
g Eventd v Unlock Door
B Zonel ¥ Lock Door
i Zone2 Bt Button Pressed —
B Zoned + Exit Butten Released
B Zonet ' Normally Open Door
v Normally Close Door
+ Door2 + Abnormally Open Door
& Door3 v Open Door Timeout
+ Doord + Remotely Open Door
| Remotely Close Door
4 Dewenic Ao Dotk
Table 1. 1 Linkage Actions for Access Control Event
Linkage Actions Descriptions
. ) The client software gives an audible warning when alarm is
Audible Warning

triggered. You can select the alarm sound for audible warning.

Send an email notification of the alarm information to one or

Email Linkage .
more receivers.

Display the alarm information on the E-map.
Alarm on E-map | Note: This linkage is only available to access control point and
alarm input.

Alarm Triggered | The image with alarm information pops up when alarm is
Pop-up Image | triggered.

7.11.2 Event Card Linkage

Click Event Card Linkage tab to enter the following interface.
Note: The Event Card Linkage should be supported by the device.
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Event Card Linkage Linkage Details Add Delete H Save
Soarc o
st = Event Source

Event Link... Device E Device Tamp Card Linkage

4 172.10.18.69
4 172.10.21.186
4 172.10.18.81

MAC Linkage

Linkage Target
Host Buzzer Enable Capture Disable Enable Recording Disable Enable
Card Reader Buzzing Alarm Output
Name Enable Name Enable
Access Control Point
Name Open Close Remain Open |Remain Closed

Select the access control device from the list on the left.
Click Add button to add a new linkage. You can select the event source as Event Linkage, Card
Linkage, or MAC Linkage.

Event Linkage

For the event linkage, the alarm event can be divided into four types: device event, alarm input,
door event, and card reader event.

Steps:
1. Click to select the linkage type as Event Linkage, and select the event type from the dropdown
list.

For Device Event, select the detailed event type from the dropdown list.
For Alarm Input, select the type as alarm or alarm recovery and select the alarm input
name from the table.
For Door Event, select the detailed event type and select the source door from the table.
For Card Reader Event, select the detailed event type and select the card reader from the
table.
2. Set the linkage target, and switch the property from to @ to enable this function.
Host Buzzer: The audible warning of controller will be enabled/disabled.
Capture: The real-time capture will be enabled.
Card Reader Buzzer: The audible warning of card reader will be enabled/disabled.
Alarm Output: The alarm output will be enabled/disabled for notification.
Access Control Point: The door status of open, close, remain open, and remain closed will
be enabled.
Notes:
The door status of open, close, remain open, and remain close cannot be triggered at
the same time.
The target door and the source door cannot be the same one.

95



Video Access Control Terminal-User Manual

3. Click Save button to save and take effect of the parameters.

Card Linkage

Steps:

1. Click to select the linkage type as Card Linkage.

2. Input the card No. or select the card from the dropdown list.

3. Select the card reader from the table for triggering.

4. Set the linkage target, and switch the property from to @ to enable this function.
Host Buzzer: The audible warning of controller will be enabled/disabled.
Capture: The real-time capture will be enabled.
Card Reader Buzzer: The audible warning of card reader will be enabled/disabled.
Alarm Output: The alarm output will be enabled/disabled for notification.
Access Control Point: The door status of open, close, remain open, and remain closed will
be enabled.

5. Click Save button to save and take effect of the parameters.

MAC Linkage

Steps:

1. Click to select the linkage type as MAC Linkage.

2. Input the MAC address of the event source.

MAC Address Format: AA:BB:CC:DD:EE:FF.

3. Set the linkage target, and switch the property from to @ to enable this function.
Host Buzzer: The audible warning of controller will be triggered.
Capture: The real-time capture will be triggered.
Recording: The recording will be triggered.
Note: The device should support recording.
Card Reader Buzzing: The audible warning of card reader will be triggered.
Alarm Output: The alarm output will be triggered for notification.
Zone: Arm or disarm the zone.
Note: The device should support zone function.
Access Control Point: The door status of open, close, remain open, and remain closed will
be enabled.

4. Click Save button to save and take effect of the parameters.

7.11.3 Cross-Device Linkage

Purpose:

You can assign to trigger other access control device’s action by setting up a rule when the access
control event is triggered.

Click Cross-Device Linkage tab to enter the following interface.
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Access Control Cross-Device Link. Access Control Cross-Device Linkage Add Delete K save
Search... 4]
Event Source
B Event Linkage_Device Tam... . N - .
@ EventLinkage: Device Event |~ Device Tamperin... v Card Linkage:
Controller List: 1= Access Cotrol Terminal v
Linkage Target
Controller List & Access Cotrol Terminal v
Alarm Qutput:
Mame Property
Alarm Output1 Disable Enable
Access Control F... | Name Open Close Remain Open Remain Closed
Doorl Di... En... Di... En.. Di... En... Dis. En...

Click Add button to add a new client linkage. You can select the event source as Event Linkage or
Card Linkage.

Event Linkage

For the event linkage, the alarm event can be divided into four types: device event, alarm input,
door event, and card reader event.
Steps:
1. Click to select the linkage type as Event Linkage, select the access control device as event
source, and select the event type from the dropdown list.
For Device Event, select the detailed event type from the dropdown list.
For Alarm Input, select the type as alarm or alarm recovery and select the alarm input
name from the table.
For Door Event, select the detailed event type and select the door from the table.
For Card Reader Event, select the detailed event type and select the card reader from the

table.
2. Set the linkage target, select the access control device from the dropdown list as the linkage
target, and switch the property from to @ to enable this function.

Alarm Output: The alarm output will be triggered for notification.
Access Control Point: The door status of open, close, remain open, and remain close will
be triggered.
Note: The door status of open, close, remain open, and remain close cannot be triggered
at the same time.

3. Click Save button to save parameters.

Card Linkage

Steps:
1. Click to select the linkage type as Card Linkage.
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2. Select the card from the dropdown list and select the access control device as event source.
Select the card reader from the table for triggering.
4. Set the linkage target, select the access control device from the dropdown list as the linkage
target, and switch the property from to @ to enable this function.
Alarm Output: The alarm output will be triggered for notification.
5. Click Save button to save parameters.

w

7.12 Door Status Management

Purpose:

The door status of the added access control device will be displayed in real time. You can check the
door status and the linked event(s) of the selected door. You can control the status of the door and
set the status duration of the doors as well.

7.12.1 Access Control Group Management

Purpose:

Before controlling the door status and setting the status duration, you are required to organize it
into group for convenient management.

Perform the following steps to create the group for the access control device:

Steps:

1. Click E=a

2. Click Group tab to enter the Group Management interface.

ED Device @ Group

on the control panel to open the Device Management page.

Resource 4 s  Access Confrol Point of Group Access Controller(1)

Search P
Search... » Import WModify 3 Delete Remote Configuration Filter

CVR Nickname : P Device Serial Mo.
HEIEEET Doorl_Access Controller 10166111
1018.146.86
1016,6.250
1018.146.81
1017.137.250
10166111
10166.104
Door Station
= Access Controller
Enceding Channel
Alarm Input

Zone

3. Perform the following steps to add the group.
1) Click -# to open the Add Group dialog box.
2) Input a group name as you want.
3) Click OK to add the new group to the group list.
You can also check the checkbox Create Group by Device Name to create the new group by
the name of the selected device.
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Add Group x

Group Name: | ]

Create Group by Device Name

OK Cancel

4. Perform the following steps to import the access control points to the group:
1) Click Import on Group Management interface, and then click the Access Control tab to
open the Import Access Control page.
Notes:
You can also select Alarm Input tab and import the alarm inputs to group.
For the Video Access Control Terminal, you can add the cameras as encoding channel
to the group.
2) Select the names of the access control points in the list.
3) Select a group from the group list.
4) Click Import to import the selected access control points to the group.
You can also click Import All to import all the access control points to a selected group.

Import

¥m Encoding Channel A Alarminput 8 Third-party Encoding Device Camera B8 Zone Access Control Point

Access Control Point 2 Group

r ) Search... p

Doorl 1 10.166.85-Access Control Point

+ 1 10166222-Ac I Point

1 10.16,6.250-Ac

Import

Import All

5. After importing the access control points to the group, you can click =, or double-click the
group/access control point name to modify it.

7.12.2 Anti-control the Access Control Point (Door)

Purpose:
You can control the status for a single access control point (a door), including opening door, closing
door, remaining open, and remaining closed.

Click E icon on the control panel to enter the Status Monitor interface.

99



Video Access Control Terminal-User Manual

Door Status | Card Swiping Record Access Control Alarm

Access Conirol Group Status Information  Status Duration |: Open Door Close Door E Remain Open Remain Closed Capture

hel

Search...

10.18.146.81
10.16.6.85

Operating Record

Seria-l Mo, Event Time Door Group Door Operation Operation Result Capture
3 2017-01-18 20:2... 1016.6.222 Doorl 10.16.6.222 Open Door Operation com..,
2 2017-01-18 20:2... 1016.6.222 Doorl_1016.6.222 Door Remain O... Operation com...
1 2017-01-18 20:2... 1016.6.222 Doorl_10.16.6.222 Open Door Operation com...

Steps:

1. Select an access control group on the left. For managing the access control group, refer to
Chapter 7.12.1 Access Control Group Management.

2. The access control points of the selected access control group will be displayed on the right.

Click icon on the Status Information panel to select a door.
3. Click the following button listed on the Status Information panel to control the door.
B openDoor : Click to open the door once.
Clese Door |+ Click to close the door once.
Bl Remain Open : Click to keep the door open.
Remain Closed|: Click to keep the door closed.
&icapure : Click to capture the picture manually.
4. You can view the anti-control operation result in the Operation Log panel.
Notes:
If you select the status as Remain Open/Remain Closed, the door will keep open/closed until a
new anti-control command being made.
The Capture button is available when the device supports capture function. And it cannot be
realized until the storage server is configured.
If the door is in remain closed status, only super card can open the door or open door via the
client software.

7.12.3 Status Duration Configuration

Purpose:
You can schedule weekly time periods for an access control point (door) to remain open or remain
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closed.
In the Door Status module, click Status Duration button to enter the Status Duration interface.

Status Duration

|

Access Control List Door Status Configuration S copyto | save
[Bearch ] 7 M Remain Open Remain Closed {£.] Copy to Whole Week ¥ Delete Duration I Clear
+ B
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Steps:
1. Click to select a door from the access control device list on the left.
2. Onthe Door Status Configuration panel on the right, draw a schedule for the selected door.
1) Select a door status brush as = ®RemanOpen | gf RemainClosedegy),
Remain Open: The door will keep open during the configured time period. The brush is
marked as .,
Remain Closed: The door will keep closed during the configured duration. The brush is
marked as mm.
2) Click and drag on the timeline to draw a color bar on the schedule to set the duration.

Door Status Gonfiguration :'i Copy to H Save

M Remain Open Remain Closed @Copytn Whaole Week > Delete Duration m Clear
[ 2 4 6 ] 10 12 14 16 18 20 22 24
i, O O S
)] 2 4 [ s 10 12 14 16 18 20 22 24
Tue | N R
)] 2 4 [ s 10 12 14 16 18 20 22 24
wed [ S S S
[ 2 4 6 s 10 12 14 16 18 20 22 24
o ]
[ 2 4 6 s 10 12 14 16 18 20 22 24
a. ]
[ 2 4 [ 8 10 12 14 16 18 20 22 24
ot | O SO S S
[ 2 4 [ 8 10 12 14 16 18 20 22 24
sun | O S

3) When the cursor turns to !:“!I, you can move the selected time bar you just edited. You can
also edit the displayed time point to set the accurate time period.
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When the cursor turns to E&a#, you can lengthen or shorten the selected time bar.
3. Optionally, you can select the schedule time bar and click Copy to Whole Week to copy the
time bar settings to the other days in the week.
4. You can select the time bar and click Delete Duration to delete the time period.
Or you can click Clear to clear all configured durations on the schedule.
5. Click Save to save the settings.
6. You can click Copy to button to copy the schedule to other doors.

7.12.4 Real-time Card Swiping Record

Click Card Swiping Record tab to enter the following interface.

Door Status  Card Swiping Record | Access Control Alarm

Card No. Person Mame Organization Event Time Door Position Direction Operation e

Person No.:
Person Name
Gender.

ID Type:

ID No.:
Organization:
Phone No.:
Address

Email:

The logs of card swiping records of all access control devices will display in real time. You can view the details of the
card swiping event, including card No., person name, organization, event time, etc.
You can also click the event to view the card holder details, including person No., person name, organization, phone,

contact address, etc.

7.12.5 Real-time Access Control Alarm

Purpose:

The logs of access control events will be displayed in real time, including device exception, door event, card reader
event, and alarm input.

Click Access Control Alarm tab to enter the following interface.
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Subscribe

Alarm T):pe Alarm Time Alarm Location | Alarm Content Operation
Remote: Disarm... 2016-12-1613:5... Access Controller Remote: Disarm...

Remote: Arming  2016-12-1613:5... Access Controller Remote: Arming

Remote: Login 2016-12-1613:5... Access Controller Remote: Login

Remote: Disarm... 2016-12-1613:5... Access Controller Remote: Disarm...

Remote: Logout  2016-12-1613:5... Access Controller Remote: Logout

Remote: Login 2016-12-1613:5... Access Controller Remote: Login

Remote: Arming  2016-12-1613:4... Access Controller Remote: Arming

Remote: Login 2016-12-1613:4... Access Controller Remote: Login

Remote: Disarm... 2016-12-1613:4... Access Controller Remote: Disarm...

Doorlocked  2016-12-1613d4.. Doorl Door Locked 2,
Unlock 2016-12-1613:4... Doorl Unlock 2,
Remote: Arming  2016-12-16134... Access Controller Remote: Arming
Remote: Login  2016-12-16134... Access Controller Remote: Login
Remote: Disarm... 2016-12-16134... Access Controller Remote: Disarm...
Steps:
1. All access control alarms will display in the list in real time.
You can view the alarm type, alarm time, location, etc.
Click & to view the alarm on E-map.
You can click or to view the live view or the captured picture of the triggered camera when the alarm is

trigged.
Note: For setting the triggered camera, refer to Chapter 7.11.1 Access Control Event Linkage.

4. Click Subscribe to select the alarm that the client can receive when the alarm is triggered.

Device Exception  Door Event Card Reader Event Alarm Input

S Al

' Device Tampering Alarm

' Mo Memory Alarm

" Network Disconnected

+ Network Recovered

v Low Battery Voltage

v Low Battery Voltage Recovered

| AC Power Off

OK Cancel

1) Check the checkbox(es) to select the alarm(s), including device exception alarm, door event alarm, card
reader alarm, and alarm input.
2) Click OK to save the settings.

7.13 Arming Control

Purpose:
You can arm or disarm the device. After arming the device, the client can receive the alarm information from the
device.
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Steps:
1. Click Tool->Device Arming Control to pop up the Device Arming Control window.
2. Arm the device by checking the corresponding checkbox.
Then the alarm information will be auto uploaded to the client software when alarm occurs.

Device Arming Control X

Hikvision Device

< Al Arming Status
| 1016.6.250
~ 10166171
< 101814681
| 1017.137.250

~ 1016.6.111

PoewmEw

7.14 Live View and Playback Settings

Purpose:

The parameters for live view and playback, including picture format, pre-play duration, etc., can be

set.

Steps:

1. Open the System Configuration page.

2. Click the Live View and Playback tab to enter the Live View and Playback Parameter Settings
interface.

3. Configure the live view and playback parameters. For details, see Table 8-1 Live View and
Playback Parameters.

4. Click Save to save the settings.
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Set the parameters of live view and playback

(e-g.. picture format, merging mode of downloaded video files, etc.)

Picture Format:

Merge Downloaded Video Files:

Search Video File Stored in

Pre-Play for:

v Enable Screen Toolbar Display

v Prioritize Playback of Video Files on Storage Server

v Resume Latest Live View Status After Restart
Disconnect Background Videos in Single Live View
Enable Wheel for Zoom

Skip Unconcerned Video during VCA Playback

JPEG v

Mot Merged v

Storage ServerandD... |+

Mone s

Default Value Save

Table 7-1 Live View and Playback Parameters

Parameters

Description

Picture Format

Set the file format for the captured pictures during live view or
playback.

Merge Downloaded
Video Files

San set the maximum size of merged video file for downloading
the video file by date.

Search Video Files
Stored in

Set to search the video files stored in the local device, in the
storage server, or both in the storage server and local device for
playback.

Pre-play for

Set the pre-play time for event playback.
Note: You should set it as None to check the live view and the
playback.

Enable Screen
Toolbar Display

Show the toolbar on each display window in live view or
playback.

Prioritize Playback
of Video Files on
Storage Server

Play back the video files recorded on the storage server
preferentially.

Otherwise, play back the video files recorded on the local
device.

Resume Latest Live

Resume the latest live view status after you log into the client

View Status After .
again.
Restart
Disconnect In multiple-window division mode, double-click a live video to

Background Videos

display it in 1-window division mode, and the other live videos
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in Single Live View

will be stopped for saving the resource.

Enable Wheel for
Zoom

Enable to use the mouse wheel for zoom in or out of the video
in PTZ mode, or for zoom in or restoring of the video in digital
zoom mode. In this way, you can directly zoom in or out (or
restore) the live video by scrolling the mouse.

Skip Unconcerned
Video during VCA
Playback

Enable to skip the unconcerned video during VCA playback and
the unconcerned video won’t be played during VCA playback.

7.15 Live View

Purpose:

For the surveillance task, you can view the live video of the added network cameras, video
encoders and video intercom device on the Main View page. And some basic operations are
supported, including picture capturing, manual recording, PTZ control, etc.

Before you start:

A camera group is required to be defined for live view.
You can set the rotate type if necessary in the Group Management. For details, refer to User
Manual of iVMS-4200 Client Software.

Click the n icon on the control panel,

or click View->Main View to open the Main View page.

Main View Page
1 View List
2 Camera List
3 PTZ Control Panel

4 Display Window of Live View

5 Live View Toolbar

Camera Status:
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-] The camera is online and works properly.
@ The camera is in live view.

('3} The camera is in recording status.

& The camera is offline.

Notes:

If event (e.g., motion detection) is detected for the camera, the camera icon will display as )

and the group icon will show as %1,
If the camera is offline, the client can still get the live video via the stream media server if the
stream media server is configured. The camera icon will display as @&.

Live View Toolbar:

On the Main View page, the following toolbar buttons are available:

Save View Save the new settings for the current view.

Save View as Save the current view as another new view.

O Stop Live View Stop the live view of all cameras.

B a Mute/Audio On Turn off/on the audio in live view

Resume/'Pause Click to resume/pause the auto-switch in live view.
Auto-switch

' Show/Hide the Show/Hide the configuration menu of auto-switch. Click
Menu again to hide.

Previous Go for live view of the previous page.

Next Go for live view of the next page.

Window Division Set the window division.

Display the live view in full-screen mode.
Press Esc, or you can move the mouse to the top of the
screen and click Quit Full Screen button to exit.

Full Screen You can click Lock button to lock the screen, and you can click
Unlock and input the client admin password to unlock it.
For full screen auto-switch, you can click Previous or Next
button to view the previous or next camera.

Right-click on the display window in live view to open the Live View Management Menu:
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= Stop Live View

@i Capture

(=, Print Captured Picture

» Send Email

© startRecording

& Open PTZ Control

&,_ Open Digital Zoom

Q, Enable Auto-traking

@ switch to Instant Playback  »

@ Start Two-way Audio
&2 Enable Audio

#=| Camera Status

> Remote Configuration

© Synchronization

&/ Fisheye Expansion

& start Speed Dome Linkage

{5} Unlock Door
= Full Screen

The following buttons are available on the right-click Live View Management Menu:

||

P B O &

@ &

Al

Al

[

o

=)

Stop Live View
Capture
Print
Picture

Captured

Send Email
Start/Stop Recording

Open PTZ Control

Enable Auto-tracking

Open Digital Zoom

Switch to
Playback
Start/Stop Two-way
Audio

Instant

Start/Stop IP
Two-way Audio

Enable/Disable Audio
Camera Status

Remote
Configuration

VCA Configuration

Synchronization

Stop the live view in the display window.
Capture the picture in the live view process.

Capture the current picture and then print the picture.

Capture the current picture and then send an Email notification
to one or more receivers. The captured picture can be attached.
Start/Stop the manual recording. The video file is stored in the
PC.

Enable PTZ control function on the display window. Click again to
disable the function.

Enable the auto-tracking function of the speed dome. Then the
speed dome will track the object appearing on the video
automatically. This button is only available for the speed dome
that supports the auto-tracking function.

Enable the digital zoom function. Click again to disable the
function.

Switch to instant playback mode.

Click to start/stop the two-way audio with the device in live
view.

Click to start/stop the two-way audio with the camera in live
view. This button is only available for the camera that supports
the IP two-way audio function.

Click to enable/disable the audio in live view.

Display the status of the camera in live view, including the
recording status, signal status, connection number, etc.

Open the remote configuration page of the camera in live view.

Enter the VCA configuration interface of the device if it is VCA
device.
Sync the camera in live view with the PC running the client
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software.
G Batch Time Sync Set time synchronization for devices in batch.
. ] Enter the fisheye expansion mode. Only available when the
@2 Fisheye Expansion L
device is fisheye camera.
Click to start/stop locating or tracking the target according to
D O Start/Stop Speed your demand. Only available when the device is fisheye camera.
~ *  Dome linkage For details, please refer to Chapter 2.4.8 Starting Speed Dome
Linkage.
- Click to remote unlock the door if the device is door station,
& Unlock Door ) . ;
outer door station or door station (V series).
- Full Screen Display the live view in full screen mode. Click the icon again to

exit.

7.15.1 Starting and Stopping the Live View

Starting Live View for One Camera

Steps:

1. Open the Main View page.

2. Optionally, click the icon in live view toolbar to select the window division mode for live
view.

3. Click-and-drag the camera to the display window,
or double-click the camera name after selecting the display window to start the live view.

Note: You can click-and-drag the video of the camera in live view to another display window if

needed.

Starting Live View for Camera Group

Steps:
1. Open the Main View page.
2. Click-and-drag the group to the display window,
or double-click the group name to start the live view.
Note: The display window number is self-adaptive to the camera number of the group.

Starting Live View in Default View Mode

Purpose:

The video of the added cameras can be displayed in different view modes. 4 frequently-used

default view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

Steps:

1. Open the Main View page.

2. Inthe View panel, click the icon to expand the default view list.

3. Click to select the default view mode and the video of the added cameras will be displayed in a
sequence in the selected view.

Note: Click , and you can save the default view as a custom view.

Move the mouse to the view and the following icons are available:

Fx
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Start Instant Start the instant playback of the view.
Playback
¥>  Start Auto-switch  Start switching automatically of the view.
View ~
Search... P
| 1-Screen vy
| 4-Screen
| 9-Screen

& 16-Screen

B Custom View

Starting Live View in Custom View Mode

Purpose:

The view mode can also be customized for the video live view.

Steps:

1. Open the Main View page.

2. Inthe View panel, click the icon to expand the custom view list. If there is custom view
available, you can click to start live view of the custom view.

3. Click to create a new view.

4. Input the view name and click Add. The new view is of 4-Screen mode by default.

5. Optionally, click the icon in live view toolbar and select the screen layout mode for the new
view.

6. Click-and-drag the camera/group to the display window,
or double-click the camera/group name in custom view mode to start the live view.

7. Click theicon to save the new view. You can also click to save the view as another
custom view.

Move the mouse to the custom view and the following icons are available:

Ex

Edit View Name Edit the name of the custom view.

x Delete View Delete the custom view.
Start Instant Start the instant playback of the view.
Playback
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View A
Search... o

- B Default View

L) 1-Screen

|| 4-Screen

|l 9-Screen

|l 16-Screen

- B custom View

3 ‘e

Stopping the Live View

Steps:

1. Select the display window.

2. Click the icon M that appears in the upper-right corner when the mouse pointer is over the
display window,
or click Stop Live View on the right-click menu to stop the live view of the display window.
You can also click the button E in live view toolbar to stop all the live view.

7.15.2 Manual Recording and Capture

Toolbar in Each Live View Display Window:

In each live view display window, the following toolbar buttons are available:
Capture the picture in the live view process. The

= Capt . . .
= apture capture picture is stored in the PC.
®| Start/Stop Start/Stop manual recording. The video file is stored in
R
Recording the PC.
~ Switch to Instant . .
(F) .
Playback Switch to the instant playback mode

Manual Recording in Live View

Purpose:

Manual Recording function allows you to record the live video on the Main View page manually
and the video files are stored in the local PC.

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Click @ in the toolbar of the display window or on the right-click Live View Management

Menu to start the manual recording. The icon © turnsto .
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3. Click the icon to stop the manual recording.

A prompt box with the saving path of the video files you just recorded will pop up if all the
operations succeed.
Notes:

During the manual recording, an indicator & appears in the upper-right corner of the display

window.

The saving path of video files can be set on the System Configuration interface. For details, see
Section 14.2.3 File Saving Path Settings.

For Hik Cloud P2P device, the manual recording is not supported during live view.

Viewing Local Video Files

Steps:
1. Click File->Open Video File to open the Video Files page.
2. Select the camera to be searched from the Camera Group list.

3. Click theicon b to specify the start time and end time for the search.

4. Click Search. The video files recorded between the start time and end time will be displayed.
Select the video file, and click Delete. You can delete the video file.
Select the video file, and click Send Email. You can send an Email notification with the selected
video file attached.
Select the video file, and click Save as. You can save a new copy of the video file.

Note: To send an Email notification, the Email settings need to be configured before proceeding.

Camera Group Video Files © Delete SendEmail| | Save as

10.16.1.93

Start Time:

2015-08-31 00:00:00

3]

End Time:

2015-08-31 23:50:50 =

Q Search

J
1

Double-click the video file and the video file can be played back locally.
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OOoOooas OmE

00:00:09/00:03:08

The following buttons are available on the local playback page:

El B8 cFacF Display the video in cif/4cif resolution.

n Full Screen Display the local playback page in full screen mode.

n Close Close the local playback page of the video files.

(o Pause/Play Pause/Start the playback of the video files.

[ = | Stop Stop the playback of the video files.

Speed Set the playback speed.

[ » ] Single Frame Play back the video files frame by frame.

Digital Zoom Enable the digital zoom function. Click again to

disable.

ﬂ (= | Enable/Disable Click to enable/disable the audio in the local
Audio playback.

Capture Capture the picture in the playback process.

Capturing Picture in Live View

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Click theicon in the toolbar of the display window or on the right-click Live View
Management Menu.
A small window of the captured picture will be displayed to notify whether the capturing
operation is done or not.

Note: The saving path of the captured pictures can be set on the System Configuration interface.

For details, see User Manual of iVMS-4200 Client Software.

Viewing Captured Pictures

The pictures captured in live view are stored in the PC running the software. You can view the
captured pictures if needed.

Steps:

1. Click File->Open Image File to open the Captured Images page.
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Select the camera to be searched from the Camera Group list.

Click the icon XX to specify the start time and end time for the search.

Click Search. The pictures captured between the start time and end time will be displayed.
Double-click the captured picture to enlarge it for a better view.

Select the captured picture, and click Print. You can print the selected picture.

Select the captured picture, and click Delete. You can delete the selected picture.

Select the captured picture, and click Send Email. You can send an Email notification with the
selected picture attached.

Select the captured picture, and click Save as. You can save a new copy of the selected picture.

Captured Images

Camera Group Local Images (= Print © Delete SendEmail i Saveas
2

10.16.1.93

Start Time:
2015-08-31 00:00:00 =
End Time:

2015-08-31 23:59:59 [

Q Search

7.15.3 Instant Playback

Purpose:

The video files can be played back instantly on the Main View page. Instant playback shows a piece
of the video which was remarkable, or which was unclear on the first sight. Thus, you can get an
immediate review if needed.

Before you start:

The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs
on the DVRs, NVRs, Network Cameras, etc., or on the storage servers.

Steps:

1.

Start the live view and move the mouse to the display window to show the toolbar. You can
also move the mouse to default view or custom view and click to enable the instant
playback of the selected view.

Click the icon in the toolbar and a list of time periods pops up.

30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable.

Select a time period to start the instant playback.

Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant
playback will start from 09:27:00.

Click the icon again to stop the instant playback and go back for the live view.
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Note: During the instant playback, an indicator 5] appears in the upper-right corner of the display
window.

On the instant playback page, the following toolbar buttons are available:

[« | Reverse Playback Play back the video file reversely.

m Pause/Start Playback Pause/Start the playback of the video files.

E Stop Playback Stop the playback of all cameras.

44| Slow Forward/Fast Forward Decrease/Increase the play speed of the playback.
4] Single Frame (Reverse) Play back the video files frame by frame (reversely).

Right-click on the display window to open the Instant Playback Management Menu:

« Reverse Play
44 Pause

= Stop

»» FastForward

«« Slow Forward

i» Single Frame

&_ Open Digital Zoom

K@ Capture

(= Print Captured Picture
% Send Email

© startRecording

2 Enable Audio

@ switch to Live View

= Full Screen

The following buttons are available on the right-click Instant Playback Management Menu:
4 Reverse Playback Play back the video file reversely.
i [» Pause/Play Pause/Start the instant playback in the display window.
= Stop Stop the instant playback and return to the live view mode.
] = Itz::lvard Forward/Slow Increase/Decrease the play speed of the instant playback.
i Single Frame (Reverse) Play back the video file frame by frame (reversely).
- . . Enable the digital zoom function. Click again to disable the
< Open Digital Zoom .

function.
oy Capture Capture the picture in the instant playback process.
&= Print Captured Picture Capture the current picture and then print the picture.
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Capture the current picture and then send an Email notification

Send Email } ]
to one or more receivers. The captured picture can be attached.

@  start/Stop Recording  Start/Stop clipping the video files.
) Enable/Disable Audio  Click to turn on/off the audio in instant playback.
Switch to Live View Switch to live view mode.
Full Screen E)l(?flay the instant playback in full screen mode. Click again to

7.15.4 Custom Window Division

Purpose:

The client software provides multiple kinds of pre-defined window division. You can also set
custom window division as desired.

Steps:

1.

(]
Click on the live view toolbar and select Eedt to pop up the custom window division dialog

box.

Edit Custom Window Division

Click Add to open the custom window division adding dialog box.
Note: Up to 5 custom window divisions can be added.
Set a name for the new window division as desired and click OK to save the settings.

Add Custom Window Division

MName: Window 01

OK Cancel

You can edit the name, window division (3x3, 4x4, 5x5) for it.
Click-and-drag you mouse to select the adjacent windows, and click Joint to joint them as a
whole window. You can also click Cancel to cancel the jointing.
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Edit Custom Window Division

‘Window 01 5x5 v [ Joint EH cancel

window

Save

6. Click Save to confirm the settings. Click B to back to the Main View page. Then you can click
and select the custom window division for playing live video.
Notes:
You can also enter the Remote Playback page and perform the steps above to configure
the custom window division.
For remote playback, up to 16 windows can be played back at the same time. The custom
window division with more than 16 windows is invalid for playback.

7.15.5 Other Functions in Live View

There are some other functions supported in the live view, including digital zoom, two-way audio,
camera status and synchronization.

Auxiliary Screen Preview

The live video can be displayed on different auxiliary screens for the convenient preview of
multiple monitoring scenes. Up to 3 auxiliary screens are supported.

Channel-zero

For the channel-zero of the device, you can hold the Ctrl key and double-click to display the
specific channel. Hold the Ctrl key and double-click again to restore.

Two-way Audio

Two-way audio function enables the voice talk of the camera. You can get not only the live video
but also the real-time audio from the camera. If the device has multiple two-way audio channels,
you can select the channel to start two-way audio.

The two-way audio can be used for only one camera at one time.

Camera Status

The camera status, such as recording status, signal status, connection number, etc., can be
detected and displayed for check. The status information refreshes every 10 seconds.
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Synchronization

The synchronization function provides a way to synchronize the device clock with the PC which
runs the client software.

7.16 Remote Playback

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or
the remote storage server connected, you can set the recording schedule or capture schedule for
the cameras for the continuous, alarm triggered or command triggered recording or capture. And
the video files can be searched for the remote playback.

7.16.1 Storing on Storage Device

Purpose:

You can add storage device to the client for storing the video files and pictures of the added
encoding devices and you can search the files for remote playback. The storage device can be
storage server, CVR (Center Video Recorder) or other NVR. Here we take the settings of storage
server as an example.

Before you start:

The storage server application software needs to be installed and it is packed in the iVMS-4200
software package. When installing the iVMS-4200, check the checkbox Storage Server to enable
the installation of storage server.

Adding the Storage Server
Steps:

1. Click the shortcut icon % on the desktop to run the storage server.
Notes:

You can also record the video files on the storage server installed on other PC.
If the storage server port (value: 8000) is occupied by other service, a dialog box will pop
up. You should change the port No. to other value to ensure the proper running of the
storage server.

2. Open the Device Management page and click the Server tab.

Click Add New Device Type, select Storage Server and click OK.

4. Click Storage Server on the list to enter the Storage Server Adding interface.

w
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= Server @ Group

Device for Management (0)

Organization
&5 Encoding Device/Door Sta. Add Device Moaiy Delete Remate Confi GVR Gonfigura SAN Configura._. | Filter
48 Decoding Device Nickname 4 |IP Device Serial No Net Status

BE cascading Server

Video Wall Controller

@ Third-party Encoding Device

@ Securily Control Panel

& Indoor Station/Master Station
Lo |

B Stream Media Server

B3 Transcoder

Add New Device Type

Online Device (0) Refresn Every 605 ¥
Add 1o Client Add All Modify Netinfo Restore Default Password Filter
P “ | Device Type Port Device Serial No Added

Storage server: CUR/VIS-4200
storage server

5. Add the storage server.

Formatting the HDDs

The HDDs of the storage server need to be formatted for the video file and picture storage.

Steps:

1. Select the added storage server from the list and click Remote Configuration.

2. Click Storage->General, to enter the HDD Formatting interface.

3. Select the HDD from the list and click Format. You can check the formatting process from the
process bar and the status of the formatted HDD changes from Unformatted to Normal Status.

Note: Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the

formatted HDDs will not be deleted.

HDD settings.

[™ HDD No. | Capacity(MB) Free Space (... | Status Type Group Mo. Property
1 139998 1126 Mormal Local Group00 Read\\rite
2 139996 400 Maormal Local Group00 Read\Write
3 136944 1152 Mormal Local Group00 ReadWrite
V| 4 1992294 310713 Unformatted Local Group00 Readrite
Format || update Al
Process:

0%

SAN and CVR Configuration

Purpose:

Client provides SAN configuration and CVR configuration to conveniently set the logical volume and
CVR function for CVR device. For detailed introduction about SAN configuration and CVR
configuration, refer to the User Manual of the CVR.

Note: This function should be supported by the device.

Select the added CVR from the list and click CVR Configuration or SAN Configuration.
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Configuring Storage Schedule

Before you start:
The storage server needs to be added to the client software and the HDDs need to be formatted
for the video file storage.

Steps:

1. Open the Storage Schedule page.

2. Select the camera from the Camera Group list.

3. Select the storage server from the Storage Server drop-down list.
Note: You can click Storage Server Management to add, edit or delete the storage server.

4. Check the checkbox Recording Schedule to enable storing the video files.
You can also check the checkbox Picture Storage to store the alarm pictures of the camera
when event occurs.
For the network cameras with the function of heat map or people counting, the Additional
Information Storage checkbox is available. You can click VCA Config to set the VCA rule for the
camera, and check the Additional Information Storage checkbox and the heat map, people
counting data and road traffic data will be uploaded to the storage server.
Note: For detailed configuration about setting the VCA rule, please refer to the User Manual of
the camera.

5. Select the schedule template for recording from the drop-down list.
If you need to edit or customize the template, see Configuring Recording Schedule Template.

6. Click Advanced Settings to set the pre-record time, post-record time and other parameters for
recording.

7. Click Set Quota to enter the HDD management interface of the storage server. You can set the
corresponding quota ratio for record, picture and additional information.
Example: If you set the record quota as 60%, then the 60% of the storage space can be used for
storing the video files.

8. Click Save to save the settings.

Storage Schedule Copy to H Save

Storage of Encoding Se.
+ Recording Schedule: Template 01 s Edit Advanced Settings

« Capture Schedule: Template 01 v Edit Advanced Settings

Storage Server

Storage Server ﬂ Storage Server 01 « Storage Server Management

Storage Content: + Recording Schedule Template 01 ) Edit Advanced Settings
+ Picture Storage Staring the alarm pictures of the camera
/| Additional Information Storage VCA Config

Storage Quota: Record Quota:50% Set Quota
Picture Quota Ratio'30%

Additional Information Quota:20%

Note: The storage server supports storage of line crossing detection alarm, intrusion detection
alarm, region entrance detection alarm, region exiting detection alarm, fast moving detection
alarm, people gathering detection alarm, loitering detection alarm, parking detection alarm, object
removal detection alarm, and unattended baggage detection alarm recording.
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7.16.2 Normal Playback

Purpose:

The video files stored on the local device or the storage server can be searched by camera or
triggering event, and then can be played back remotely.

Before you start:

You can set to play back the video files stored in the local device, in the storage server, or both in
the storage server and local device. For details, refer to 8.5.1 Storing on Storage Device.

Optionally, you can set the cameras rotate direction for playback in Group Management. Refer to
Editing the Group/Camera of Chapter 8.3 Group Management.

Click the | he) icon on the control panel,
or click View->Remote Playback to open the Remote Playback page.

Camera ~

06.15 00:00-06.21 23:59 5 &
Search [o]
+/ 3 10161110
*) 1 10.161.72

+ 10161102

+) 23 POS 1

BREH

2016/06/21 00:00:00

Alarm Input ~
Remote Playback Page
1 Camera List
2 Display Window of Playback
3 Playback Control Buttons
4 Timeline
5 Calendars
6 Search Condition

Switching Video Stream for Playback
Purpose:

Optionally, you can switch between main stream and sub-stream for playback.
Before you start:

Set the video stream for recording as Dual-Stream.
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Note: This function should be support by the device.

Steps:

1. Enter Group Management interface and open the Modify Camera dialog (refer to Editing the
Group/Camera of Chapter 8.3 Group Management).

2. Set the video stream of the camera to main stream or sub-stream.

Searching Video Files for Normal Playback

Steps:

1. Open the Remote Playback page.

2. Click the calendars icon [ to activate the calendars dialog.
Select the start and end date and set the accurate time.
Click OK to save the searching period.

3. Click-and-drag the camera or group to the display window,
or double-click the camera or group to start the playback.

4. The found video files of the selected group or camera will be displayed on the right of the
interface in chronological order. You can filter the results through the Filter text field.
The first video file will be played back automatically by default.

Filter
B 2014-11-26 21:52:55
B 2014-11-26 23:02:28
B 20141127 00:11:39
B 2014-11-27 01:21:44
B 2014-11-27 02:31:55
B 20141127 02:42:15
B 2014-11-27 04:52:44
B 2014-11-27 06:03:19
B 20141127 07:13:33
B 2014-11-27 08:23:01
B 2014-11-27 09:32:18
B 20141127 10:41:48
B 2014-11-27 11:51:40

B 20141127 140958

B 2014-11-27 162855

B 2014-11-27 13:00:53 ‘ ‘

Notes:
Up to 16 cameras can be searched simultaneously.
In the calendar, the date which has scheduled records will be marked with .4 and the date
with event records will be marked with 4.

Playing Back Video Files

After searching the video files for the normal playback, you can play back the video files in the
following two ways:
Playback by File List
Select the video file from the search result list, and then click the icon & on the video file,
or double-click the video file to play the video on the display window of playback.
You can also select a display window and click the icon B in the toolbar to play back the
corresponding video file.
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Playback by Timeline
The timeline indicates the time duration for the video file, and the video files of different types
are color coded. Click on the timeline to play back the video of the specific time.

You can click B or B to scale up or scale down the timeline bar.

You can drag the timeline bar to go to the previous or the next time period.

You can use the mouse wheel to zoom in or zoom out on the timeline.

B 2016-06-1819:18:36
B 2016-06-1819:48:34
B 2016-06-1819:54:12
B 2016-06-18 20:24:10
B 20160618 20:20:47
B 2016-06-18 20:50:46
B 2016-06-18 21:20:44
B 2016-06-18 21:31:28
B 2016-06-18 22:01:26
B 2016-06-18 22:31:25
B 2016-06-18 23:01:23
B 2016-06-18 2311:36
B 2016-06-18 23:41:34
B 2016-06-1900:11:32
B 2016-06-19 00:28:32

B 7016.06-1900:58:20
Bl ==

2016/06/15 15:43:50

On the Normal Playback page, the following toolbar buttons are available:

O

Reverse Playback
Pause/Start
Playback

Stop Playback

Single Frame
(Reverse)
Single Frame

Slow Forward/Fast
Forward
Volume

Event Playback

ATM Playback
POS Playback

VCA Playback

Play back the video file reversely.
Pause/Start the playback of the video files.

Stop the playback of all cameras.

Play back the video files frame by frame reversely. You can
also scroll down the mouse wheel to play the video file frame
by frame reversely.

Play back the video files frame by frame. You can also scroll
down the mouse wheel to play the video file frame by frame.

Decrease/Increase the play speed of the playback.

Click to turn on/off the audio and adjust the audio volume.
Search the recordings triggered by event, such as motion
detection, video loss or video tampering.

Search the recordings of ATM devices.

Search the recordings which contain POS information.

Set the VCA rule to the searched video files that VCA event
occurs, including VCA Search, Intrusion and Line Crossing.
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Window Division Set the window division.
Display the vi I k in full- . P E
Full Screen |§p ay the video playback in full-screen mode. Press ESC to
exit.
=3 T Async/Sync Click to play back the video files
Playback synchronously/asynchronously.
Download the video files of the camera and the video files are
B Download stored in the PC. You can select to download by file, by date,
or by tag.
Add default tag for the video file to mark the important video
7] Tag point. You can edit the tag or go to the tag position via the

right-click menu.
Display the record types as desired. E.g., you can select to
display only the event recording.
bkl Accurate Positioning  Set the accurate time point to play back the video file.
Date The day that has video files will be marked with .

Filter

Right-click on the display window in playback to open the Playback Management Menu:
<« Reverse Play
14 Pause
= Stop
»» Fast Forward
<« Slow Forward

» Single Frame

>
&, Open Digital Zoom
i

[I* Tag Control »

Transcoding Playback 4

% Accurate Positioning »
Capture

o Other Capture Modes >

0 Start Recording
4 Download

4@ Enable Audio

2/ Fisheye Expansion

B Full Screen

The following items are available on the right-click Playback Management Menu:

< Reverse Playback Play back the video file reversely.
i1/»  Pause/Start Pause/Start the playback.
- Stop Stop the playback.
rr Fast Forward Play back the video file at a faster speed.
= Slow Forward Play back the video file at a slower speed.

/=«  Single Frame (Reverse) Play back the video file frame by frame (reversely).

Enable the digital zoom function. Click again to disable the

function.

Add default (default tag name TAG) or custom tag (customized
- Tag Control tag name) for the video file to mark the important video point.

You can also edit the tag or go to the tag position conveniently.

W Accurate Positioning Set the accurate time point to play back the video file.

7] Capture Capture the picture in the playback process.

& Open Digital Zoom
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Print Captured Picture: Capture a picture and print it.
Send Email: Capture the current picture and then send an Email
notification to one or more receivers. The captured picture can
be attached.
Custom Capture: Capture the current picture. You can edit its
name and then save it.
Start/Stop the manual recording. The video file is stored in the
PC.
Download the video files of the camera and the video files are
stored in the PC. You can select to download by file or by date.
@) Enable/Disable Audio Click to enable/disable the audio in playback.

& Fisheye Expansion Enter the fisheye playback mode.
Display the playback in full-screen mode. Click the icon again or
press Esc key to exit.

£ Other Capture Modes

©/@ start/Stop Recording

Download

=

o= Full Screen

Downloading Video Files

During playback, you can click B on the toolbar to download the video files of the camera to the
local PC. You can select to download by file, by date, or by tag.
Download by Files
Steps:
1. Click Download by Files tab in the File Download interface. You can view the video files
information of selected camera.
2. Check the checkbox of the video file and the total size of the selected files will be shown below.
3. Click Download to start downloading the file to the local PC.
You can input the flow (0 to 32768 kbps) and click Set to control the downloading speed.
4. Optionally, you can click Stop to stop downloading manually.

File Download(IP Camera4_Intersection) x

Download by Files | Download by Date Download by Tag

Index Start Time End Time Size Status

1 2016-02-27 11:22:01 2016-02-27 12:37:58 1,017.47 MB Waiting ‘
2 2016-02-27 12:27:58 2016-02-27 13:33:52 1,017.58 MB Waiting

3 2016-02-27 13:33:52 2016-02-27 14:39:46 1,017.71 MB Waiting

4 2016-02-27 14:39:46 2016-02-27 15:45:36 1,017.23 MB Waiting

5 2016-02-27 15:45:36 2016-02-27 16:51:30 1,017.45 MB Waiting

6 2016-02-27 16:51:30 2016-02-27 17:58:50 1,017.65 MB Waiting

7 2016-02-27 17:58:50 2016-02-27 19:14:01 1,017.54 MB Waiting

8 2016-02-27 19:14:01 2016-02-27 20:29:15 1,017.63 MB Waiting
9 2016-02-27 20:29:15 2016-02-27 21:44:40 1,017.73 MB Waiting
10 2016-02-27 21:44:40 2016-02-27 22:55:20 1,017.69 MB Waiting
11 2016-02-27 22:55:20 2016-02-28 00:05:13 1,017.74 MB Waiting
12 2016-02-28 00:05:13 2016-02-28 01:14:44 1,017.74 MB Waiting
13 2016-02-28 01:14:44 2016-02-28 02:24:02 1,017.91 MB Waiting
14 2016-02-28 02:24:02 2016-02-28 03:33:14 1,017.58 ME Waiting
15 2016-02-28 03:33:14 2016-02-28 04:42:24 1,017.53 ME Waiting

The Selected Files Size: 0 bytes
Free Disk Space Size: 2677 GB

Flow Ctrl{kbps): Set Download Stop Cancel
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Download by Date
Steps:
1. Click Download by Date tab in the File Download interface.
2. Check the checkbox of the time duration to enable it, and click £ to set the start and end
time.
3. Click Download to start downloading the file to the local PC. The progress bar shows the
downloading process.
You can input the flow (0 to 32768 kbps) and click Set to control the downloading speed.
4. Optionally, you can click Stop to stop downloading manually.
File Download(IP Camerad_Intersection) x
Download by Files | Download by Date | Download by Tag
Start Time End Time
[+ Duration 1 2016-02-27 00:00:00 ﬂ 2016-03-04 23:59:59 ﬂ
Duration 2 2016-02-27 00:00:00

Duration 3 2016-0

Duration 4 2016-02-27 00:00:00

The Selected Files Size: 86.36 GB
Free Disk Space Size: 26.08 GB

Flow Cirl{kbps): Set Download Stop Cancel

Note: When downloading video file of one time duration, you can set to merge the video files. The
video files in the set time duration can be merged for downloading. For configuring merging
downloaded video files, refer to 8.2 Live View and Playback Settings.

Download by Tag

Steps:

1. Click Download by Tag tab in the File Download interface. The added tags will be displayed.

2. Check the checkbox of the tag and the total size of the selected files will be shown below.

3. Click Download to start downloading the selected file (30 seconds before the selected tag to 30
seconds after the tag) to the local PC. You can input the flow (0 to 32768 kbps) and click Set to
control the downloading speed.

4. Optionally, you can click Stop to stop downloading manually.
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File Download(IP Camera4_Intersection) x

Download by Files Download by Date Download by Tag

m| Index | Tag Name Time Size Status
< 1 TAG 2016-02-29 12:24:52 1584 MB Waiting
2 TAG 2016-02-29 13:08:29 1584 MB Waiting

3 TAG 2016-02-29 14:32:08 1578 MB Waiting

The Selected Files Size: 15.84 MB
Free Disk Space Size: 26.08 GB

Flow Ctrl{kbps): Set Download Stop Cancel

7.16.3 Event Playback

Purpose:
The recordings triggered by event, such as motion detection, VCA detection or behavior analysis,
can be searched for Event Playback and this function requires the support of the connected device.

Searching Video Files for Event Playback

Steps:

1. Open the Remote Playback page.

2. Select the camera and start the normal playback. Refer to Chapter 8.5.2 Normal Playback.

3. Click and the motion detection triggered recording will be searched by default.

4. Click the calendars icon [ to activate the calendars dialog box.

Select the start and end date and set the accurate time.

Click OK to save the searching period.

Note: In the calendar, the date which has scheduled records will be marked with .4 and the
date with event records will be marked with 4.

5. Select the event type from the drop-down list and the found video files will be displayed. You
can filter the results by inputting the keyword in the Filter text field. Or you can click * to go
back to the normal playback.

6. Select the video file from the search result list, and then click the icon & on the video file, or

double-click the video file to play the video on the corresponding display window of playback.
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IP Camera1_10.16.1.110 Event Playback

Playing Back Video Files

06.17 00:00-06.17 23:59 i
34 Motion Detection

Bl Filter

[ 2016-06-17 14:39:09
=] 2016-06-17 14:50:59
=] 2016-06-17 15:04:17
= 2016-06-1715:09:03
" = ansea7150015
= 2016-06-1715:13:35
[ 2016-06-17 15:13:50
=) 2016-06-17 15:14:17
[=] 2016-06-1715:16:05
[ 2016-06-1715:16:44
[ 2016-06-1715:17:06

= 2016-06-17 15:28:47

After searching the recordings triggered by the event, you can play back the video files in the

following two ways:
Playback by File List

Select the video file from the search result list, and then click the icon in the toolbar, or
click the icon @ on the video file, or double-click the video file to play the video on the
corresponding display window of playback.

Playback by Timeline

The timeline indicates the time duration for the video file. Click on the timeline to play back

the video of the specific time.

You can click B or B to scale up or scale down the timeline bar.
You can drag the timeline bar to go to the previous or the next time period.
You can use the mouse wheel to zoom in or zoom out on the timeline.

Event PIayba Toolbar:

W= 0617

On the Remote Playback page, the following toolbar buttons are available:

Reverse Playback
11| Pause/Start Playback
E Stop Playback
Single Frame (Reverse)
Single Frame
Previous Event
Next Event

Slow Forward/Fast
= Forward
<)

Volume

/17 14:35:53

Play back the video file reversely.

Pause/Start the playback of the video files.

Stop the playback of all cameras.

Play back the video files frame by frame reversely.
Play back the video files frame by frame.

Go to the playback of the previous event.

Go to the playback of the next event.

Decrease/Increase the play speed of the playback.

Click to turn on/off the audio and adjust the audio
volume.
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— Display the video playback in full screen mode. Press
Full Screen ESCptoyexit piay
& Download Download the video files of the camera and the
video files are stored in the PC.
e . Set the accurate time point to play back the video
2016/0513110:38:37 Accurate Positioning file
Date The day that has video files will be marked with BE.

Please refer to Chapter 7.16.2 Normal Playback for the description of the right-click menu. Some
icons may not available for event playback.

Note: You can set the pre-play time for event playback in System Configuration. By default, it is 30s.
For configuring the pre-play time, refer to Live View and Playback Settings in Chapter 7.16.3 Event
Playback.
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Appendix A Tips for Scanning Fingerprint
Recommended Finger
Forefinger, middle fginger or the third finger.

Correct Scanning
The figure displayed below is the correct way to scan your finger:

You should press your finger on the scanner horizontally. The center of your scanned finger should
align with the scanner center.

Incorrect Scanning
The figures of scanning fingerprint displayed below are wrong:

Vertic Edge I
al

Environment
The scanner should avoid direct high light, high temperature, humid conditions and rain.

When it is dry, the scanner may not recognize your fingerprint successfully. You can blow your
finger and scan again after drying the finger.

Others
If your fingerprint is shallow, or it is hard to scan your fingerprint, we recommend you to use other

authentication methods.

If you have injuries on the scanned finger, the scanner may not recognize. You can change another
finger and try again.
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Appendix B DIP Switch Introduction

The DIP switch diagram is as follows:

e

Table 7-2 Description of DIP Switch

Icon Description
- Represent 1 in binary mode
- Represent 0 in binary mode

For example, binary value of the foIIowing status is: 0000 1100.

" nnnn

1 2 3 45

Table 7-3 Description of DIP Switch

No. Description DIP Switch Status
2: Security Module

1~4 Address of RS-485 0: Card Reader
5 RS-485 Direction under the Terminal | 1: Upstream;

Mode 0: Down Stream

. 1: Card Reader;

6 Working Method 0: Terminal.

Wiegand Protocol 1: Wiegand protocol of 26-bit;
/ (available when No. 6 is 1) 0: Wiegand protocol of 34-bit.

Matched Resistance 1: Enable;
8 (available for RS-485 protocol) 0: Disable.
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Appendix C Indicator and Buzzer
Description

Power on after 10s, the buzzer will beep once. When the device is powered on, the buzzer will
beep again (once). The indicator will remain red in this duration.

The buzzer descriptions are as follows:

Type Description

Card Swiping

Pressing Button

Beep Once After Card Swiping and before Scanning Fingerprint in
Multiple Authentications

Fast Beep Twice Valid Card Swiping

Slow Beep for Three Times Invalid Card Swiping

Tampering Alarm
Buzzer Alarm
Slow and Continuous Beep Not Encrypted Card Reader

Rapid and Continuous Beep

The card reader indicator descriptions are as follows:
Indicator Description
Flashing Green Once and Flashing Red for
3 Times

Powering On

After Card Swiping and before Scanning

Continuous Flashing Green . o . .
g Fingerprint in Multiple Authentications

Fingerprint Authentication Completed after

Solid Green for 3s Swiping Card in Card Swiping
Operation/Multiple Authentications

Solid Red Working Properly

Flashing Red for 3 Times Invalid Card Swiping
Card Reader Mode Offline and Registration

Continuous Flashing Red

Failure

0200001090312

132



‘ See Far, Go Further

uD06878B-D



	Chapter 1  Overview
	1.1 Introduction
	1.2 Main Features

	Chapter 2 Appearance
	2.1 Appearance of DS-K1T501SF Model
	2.2 Video Access Control Terminal Connector

	Chapter 3  Installation
	Chapter 4  Terminal Connection
	Chapter 5  Wiring Description
	5.1 External Device Wiring Overview
	5.2  The Wiring of External RS-485 Card Reader
	5.3 Card Reader Connection
	5.3.1 The Wiring of Wiegand
	5.3.2 The Wiring of RS-485 Output


	Chapter 6  Activating the Access Control Terminal
	6.1 Activating via SADP Software
	6.2 Activating via Client Software

	Chapter 7  Client Operation
	7.1 Function Module
	7.2 User Registration and Login
	7.3 System Configuration
	7.4 Access Control Management
	7.4.1 Adding Access Control Device
	Creating Password
	Adding Online Device
	Adding Devices by IP or Domain Name
	Adding Devices by IP Segment
	Adding Devices by Hik-Connect Domain
	Add Devices in Batch
	Adding Devices by EHome Account
	Adding Devices by Serial Port
	Adding Devices by IP Server
	Adding Devices by HiDDNS
	Importing Devices in Batch

	7.4.2 Viewing Device Status
	7.4.3 Editing Basic Information
	7.4.4 Network Settings
	Uploading Mode Settings
	Network Center Settings
	Wireless Communication Center Settings

	7.4.5 Capture Settings
	Linked Capture
	Manual Capture

	7.4.6 RS-485 Settings
	7.4.7 Remote Configuration
	Checking Device Information
	Editing Device Name
	Editing Time
	Setting System Maintenance
	Managing User
	Setting Security
	Configuring Network Parameters
	Configuring Upload Method
	Configuring Network Center
	Configuring Advanced Network
	Configuring Wi-Fi
	Configuring Wireless Dail Status
	Configuring HDD Parameters
	Configuring Relay Parameters
	Configuring Access Control Parameters
	Uploading Background Picture
	Configuring Face Detection Parameters
	Configuring Video and Audio Parameters
	Configuring Video Image Parameters
	Configuring Volume Input and Output
	Operating Relay
	Viewing Relay Status


	7.5 Organization Management
	7.5.1 Adding Organization
	7.5.2 Modifying and Deleting Organization

	7.6 Person Management
	7.6.1 Adding Person
	Adding Person (Basic Information)
	Adding Person (Detailed Information)
	Adding Person (Permission)
	Adding Person (Card)
	Adding Person (Fingerprint)
	Importing and Exporting Person Information
	Getting Person Information from Access Control Device

	7.6.2 Managing Person
	Modifying and Deleting Person
	Changing Person to Other Organization
	Searching Person

	7.6.3 Issuing Card in Batch

	7.7 Schedule and Template
	7.7.1 Week Schedule
	7.7.2 Holiday Group
	7.7.3 Template

	7.8 Permission Configuration
	7.8.1 Adding Permission
	7.8.2 Applying Permission

	7.9 Advanced Functions
	7.9.1 Access Control Parameters
	Door Parameters
	Card Reader Parameters

	7.9.2 Card Reader Authentication
	7.9.3 Multiple Authentication
	7.9.4 Open Door with First Card
	7.9.5 Anti-Passing Back

	7.10 Searching Access Control Event
	7.10.1 Searching Local Access Control Event
	7.10.2 Searching Remote Access Control Event

	7.11 Access Control Event Configuration
	7.11.1 Access Control Event Linkage
	7.11.2 Event Card Linkage
	Event Linkage
	Card Linkage
	MAC Linkage

	7.11.3 Cross-Device Linkage
	Event Linkage
	Card Linkage


	7.12 Door Status Management
	7.12.1 Access Control Group Management
	7.12.2 Anti-control the Access Control Point (Door)
	7.12.3 Status Duration Configuration
	7.12.4 Real-time Card Swiping Record
	7.12.5 Real-time Access Control Alarm

	7.13 Arming Control
	7.14 Live View and Playback Settings
	7.15 Live View
	7.15.1 Starting and Stopping the Live View
	Starting Live View for One Camera
	Starting Live View for Camera Group
	Starting Live View in Default View Mode
	Starting Live View in Custom View Mode
	Stopping the Live View

	7.15.2 Manual Recording and Capture
	Manual Recording in Live View
	Viewing Local Video Files
	Capturing Picture in Live View
	Viewing Captured Pictures

	7.15.3 Instant Playback
	7.15.4 Custom Window Division
	7.15.5 Other Functions in Live View
	Auxiliary Screen Preview
	Channel-zero
	Two-way Audio
	Camera Status
	Synchronization


	7.16 Remote Playback
	7.16.1 Storing on Storage Device
	Adding the Storage Server
	Formatting the HDDs
	SAN and CVR Configuration
	Configuring Storage Schedule

	7.16.2 Normal Playback
	Switching Video Stream for Playback
	Searching Video Files for Normal Playback
	Playing Back Video Files
	Downloading Video Files

	7.16.3 Event Playback
	Searching Video Files for Event Playback
	Playing Back Video Files



	Appendix A  Tips for Scanning Fingerprint
	Appendix B  DIP Switch Introduction
	Appendix C  Indicator and Buzzer Description

